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1. Introduction

ElixirForm for AFP is an interactive forms design tool
that allows you to create and edit forms in WYSIWYG
(What-You-See-Is-What-You-Get) mode using an IBM
PC, AT, PS/2 or compatible computer and optional
proof printer.

If you are familiar with previous GEM versions of Elix-
irForm for AFP, you will find that the Windows-based
version includes the same functionality plus additional
features and a new interface. You can easily import
forms created in earlier versions of ElixirForm for AFP
and edit them in the new version.

If you have never used ElixirForm for AFP before, you
will find the product highly intuitive and easy to use.

For brevity, "ElixirForm for AFP" is referred to as "Elix-
irForm" throughout this guide.

ElixirForm overview

A form created with ElixirForm is the static (or boiler
plate) component of a form, and contains elements
such as lines, boxes, text and images. The static form
is then merged with variable data for printing on AFP
high-speed laser printers.

ELIXIRFORM FOR AFP USER GUIDE 1-1
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The static data adds meaning to the variable data with
which it is merged. For example, the following variable
data from a credit application form

X 123-456-789 9876.23
X 985-234-980 11813.34

is more meaningful when merged with static data and
viewed together:

Applicant Account Account #  Account Balance
Savings X 123-456-789 $ 9876.23
Checking O $

Money Market 3 985-234-980 $11813.34

CD, IRA ] $

Visa O $

MasterCard [} $

Previously, creating and editing static forms for print-
ing on AFP printers was the responsibility of applica-
tions personnel working on mainframe computers.
Such personnel were required to define form ele-
ments using Overlay Generation Language (OGL), a
language that describes the location of line, shape,
text and image elements, as well as page size and
layout.

Limitations to this approach are:

e defining and revising an OGL form is complicated
and time-consuming

® changes to the form are not apparent when add-
ing OGL statements

® the completed OGL file must be compiled and
proof printed on the high-speed printer.

With ElixirForm, you can see each static form element
as you add or revise the element, and then generate
proofs using an optional desktop proof printer. Using
the Elixir Desktop Converter, you can compile your
forms on your PC, thus freeing your AFP printer from
these tasks.

1-2
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Depending upon the ElixirForm product you have in-
stalled, your screens and options may differ from the
figures displayed in this guide.

Customer support

Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.

If you have purchased your Elixir product directly from
Elixir Technologies then contact one of the support
center hotlines.

See the Elixir Getting Started Guide for information
about contacting your support center.

Elixir training

Elixir Technologies Corporation offers training for the
full range of Windows-based products. For more in-
formation, contact:

Elixir Learning
(805) 641-5900 ext. 6

Who should use this guide

This guide serves users needing first-time or ongoing
reference information about ElixirForm.

Users should already be familiar with Microsoft Win-
dows operations, printer and font management opera-
tions and PC peripherals, and have access to
reference manuals for related PC software and
hardware.
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Conventions

This section describes the following:

e display conventions
e typographical conventions

Display conventions

ElixirForm adheres to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and the mouse. See your
Windows manual for more information.

Many shortcut keys in the new Windows-based prod-
uct are different from those in previous GEM versions.
This is because the standard Windows operating envi-
ronment assigns certain functions to keys (for exam-
ple, <F1> is always used for Help). See the
"Keyboard shortcuts" appendix for a list of keyboard
shortcuts.

Typographical conventions

The following typographical conventions are used
throughout this guide:

® Keystrokes are shown enclosed in < > (angle
brackets). For example:

<Enter>.

® Key combinations are denoted by a plus sign be-
tween keys. For example:

<Shift> + <F1> indicates simultaneously pressing
the <Shift> and <F1> keys.

® Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:

Select [New] from the File menu.

1-4
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e Commands, options, actions and parameters that
require description are shown in bold, followed on
the next line by the description.

For example:

Delete
Deletes the selected files.

®  Steps in a procedure are shown in numbered bold
paragraphs. For example:

1. At the prompt, enter the file name and
extension.

Comments relating to a step (such as this para-
graph) are shown in regular text following the bold
paragraph.

® Commands you enter at the DOS prompt display
in larger text. Within DOS commands, variable
names and keys you press are shown in italics.
For example:

CD \ELIXIR <Enter>

On-line Help

Elixir software uses the Microsoft Windows Help pro-
gram to provide on-line Help for all functions.

For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.

The Help files included with your Elixir software in-
clude graphics created using screen drivers with large
fonts. If you use a screen driver with small fonts, the
Help file graphics may not display clearly. For opti-
mum graphics display, use a screen driver with large
fonts.

You can display on-line Help in the following ways:
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Bubble Help

Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.

Quick Help

Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
Elixirlmage) dialog box. When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen. During certain operations a message
about the function you are performing also displays in
the message area. To see these operational mes-
sages, disable quick help.

Context sensitive Help

To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays. If no
specific topic is available, the Help table of contents
displays.

Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.

Dialog box Help

Click on the [Help] button in a dialog box to view an
associated Help topic. Under Windows 95 and Win-
dows NT, right-click on a dialog box option to display
an associated Help topic.

Help pop-ups and jumps

Within Help topic text, words or phrases underlined in
green are pop-ups or jumps. When you click on a
pop-up topic, a box displays within the current Help
topic with additional information. When you click on a
jump, a different, associated Help topic displays.

1-6
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Help hypergraphics

Hypergraphics are special graphics within Help files
that contain "hot spots”. Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).

Move the cursor over a hypergraphic until a hand dis-
plays, then click on this hot spot to display a pop-up
topic, or a "jump". To close a pop-up topic, click the
mouse button. To return to the original Help topic
from a jump, click on <Back> in the Help file menu.

Organization of this guide

This guide contains the following chapter and ap-
pendices:

Chapter 1, "Introduction”, provides an overview of
ElixirForm functions, features, hardware and software
requirements, and documentation.

Chapter 2, "ElixirForm basics", provides an overview
of ElixirForm and describes basic operations for creat-
ing a form.

Chapter 3, "Menu bars", provides information on the
ElixirForm and Work area menu bars.

Chapter 4, "ElixirForm defaults", describes how to set
the defaults for a form.

Chapters 5 through 8 "Lines", "Shapes", "Text opera-
tions" and "Images" are reference sections explaining
how to create and edit elements using every icon in
the toolbox.

Chapter 9, "Stand-alone utilities”, explains the stand-
alone utilities included with ElixirForm.

Appendix A, "Keyboard shortcuts”, lists keyboard
shortcuts (fast keys).
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"Glossary", contains terms and definitions applicable
to ElixirForm and related Elixir products.

Index.

Installation

See the Elixir for AFP Getting Started Guide for instal-
lation information.

Starting ElixirForm

To start ElixirForm from the Elixir Desktop, double-
click on the ElixirForm icon. The ElixirForm Desktop
displays.

Exiting ElixirForm

To exit ElixirForm and return to the Desktop either:

®  Double-click on the Close button at the top left of
any Elixir application.

®  Press <Alt> + <F4>,
®  Press <Alt> + <X>.
®  From the File menu and select [Exit]

® Click on the [X] at the top right corner of the appli-
cation window.
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2. ElixirForm basics

This chapter describes the ElixirForm Work area and
basic operations.

ElixirForm window

To view the ElixirForm main screen, open the Elixir
Desktop and double-click on the ElixirForm icon.

The ElixirForm window displays.

Toolbox Toolbar Work area ElixirForm
menu bar menu bar

Work area

Figure 2-1. ElixirForm window
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The ElixirForm windows contains the following
features:

Toolbox

Toolbar

ElixirForm menu bar
Work area menu bar
Message area

Work area

Toolbox <F10>

The Toolbox displays on the left of the main Work
area and contains the Select/Edit, Line, Path, Box,
Circle, Text and Image tools.

If you cannot see the Toolbox, pull down the Window
menu and select [Toolbox] or press <F10>.

Tools

Message
area

Tool options

Preview
panel

Figure 2-2. Toolbox

Select a tool to display its options in the Toolbox. A
short description of the tool displays in the Message
area, and the Preview panel displays your option
selections.

Color options may or may not display, depending on
the color selected in the Page Properties dialog box.

2-2
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Select tool

Selects form or data elements for editing.

Copy

Copies any form element or design object.

Delete

Deletes the selected element(s). When a data ele-
ment is deleted, it is only removed from the Work
area. The entry in the Document window is preserved.

If you inadvertently delete an element, immediately

select [Undo] from the Edit menu to restore the de-
leted element to your form.

Group filter options

The Group Filter options from left to right are: [Line],
[Box], [Text], [Data Tag], and [Image].

Select one or more options to exclude the correspond-
ing element from group options such as moving or de-
leting. Select the option(s) a second time to turn the
filter off. See the "Grouping elements" section for in-
formation on grouping elements.

Number of Copies

Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a
number.

Press and hold <Ctrl> while clicking to
increase/decrease the value by 10.

Movement Selection

Select a movement direction for moving or copying
elements:

® [Horizontal only] - cursor moves horizontally with
element(s) attached
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® [Vertical only] - cursor moves vertically with ele-
ment(s) attached

® [Free] - cursor moves in any direction with ele-
ment(s) attached

Copy - Horizontal Distance

Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a
number.

Press and hold <Ctrl> while clicking to
increase/decrease the value by 1.

Copy - Horizontal Distance - On/Off

Enables the [Copy - Horizontal Distance] option. Se-
lect this option a second time to disable this feature.

Sticky Lines - On/Off

Perpendicular lines with ends that connect remain
stuck together when you move one of the lines. Lines
attached to box sides remain connected when you
resize the box.

Select this option a second time to disable this fea-
ture. See the “Lines” chapter for more information.

Copy - Vertical Distance

Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a
number.

Press and hold <Ctrl> while clicking to
increase/decrease the value by 1.

Copy - Vertical Distance - On/Off

Enables the [Copy - Vertical Distance] option. Select
this option a second time to disable this feature.

2-4
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Line tool

Path tool

Draws horizontal, vertical, and free lines; and specifies
line properties. See the "Lines" chapter for more infor-
mation on the options described below.

Line - Direction

Select the drawing line’s direction: [Horizontal only],
[Vertical only], [Horizontal and Verticall], or [Free].

Custom Line/Border Thickness

Specify a value (in dots) by clicking on the up or down
arrows or click in the numeric display box and enter a
value (maximum 99 dots).

You can also select: standard [Thin] 2 dot, [Medium] 4
dot, or [Thick] 6 dot line widths.

Line - Style

Select the line style: [Solid], [Dashed], or [Dotted].

Line - Color

Select a box border color from the palette in the Color
dialog box, then click on [Close]. The selected color
displays in the bottom half of the icon.

Draws paths and specifies path properties. See the
"Shapes" chapter for more information on the options
described below.

Path - Shape

Select a path shape:

® [Closed] - path automatically closes when you fin-
ish drawing the path

® [Open] - path remains open

ELIXIRFORM FOR AFP USER GUIDE 2-5



ELIXIRFORM BASICS

Path - Direction

Select a path direction;

® [Snapped] - lines drawn snap to horizontal and
vertical lines

® [Free] - lines drawn run in any direction

Path - Beginning Style

Select line beginning style: [Square], [Round], or
[Mitered].

Path - End Style

Select line end style: [Square], [Round], or [Mitered].

Custom Line/Border Thickness

Specify a value (in dots) by clicking on the up or down
arrows or click in the numeric display box and enter a
value (maximum 99 dots).

You can also select: [Thin], [Medium], or [Thick] bor-
der widths.

Line/Border Style

Select a border style: [Dotted], [Dashed], or [Solid].

Path - Finish Drawing

When you add a path to the Work area, you are in
Draw mode. When you complete a path, select this
option, double-click in the Work area or right-click in
the Work area to toggle to Done mode. You can then
draw another path or switch to another drawing tool.

Path - Color

Select a path border color from the palette in the Color
dialog box, then click on the [Close] button. The se-
lected path color displays in the bottom half of the
icon.

2-6
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Box tool

Path - Fill Color

Right-click to select a path fill color from the palette in
the Color dialog box, then click on the [Close] button.
The selected path fill color displays in the bottom half
of the icon.

Object Fill Pattern/Shading

Select a shade pattern from the Pattern dialog box.
This pattern applies each time you draw a new closed
path, until you change it using the same procedure.
Select [Hollow] for no shading.

Path - Connection Radius

Specify the value of the path connection radius (in
pels) by clicking on the up or down arrows, or click in
the numeric display box and enter a value (maximum
299 pels).

You can also select: [Small] 10 pels, [Medium] 20
pels, [Large] 30 pels, [Square], [Radius Half], or [Ra-
dius Maximum].

Draws boxes and specifies box properties. See the
"Boxes" chapter for more information on the options
described below.

Box Predefined Shape

Select the box corner style: [All corners square], [All
corners rounded], [Top rounded/bottom square], [Top
square/bottom  rounded], [Left rounded/bottom
square], or [Left square/right rounded].

Box - Positioning - Center/Top Left

Select the top half of this option to center the top left
corner of the box on grid coordinates. Select the bot-
tom half of the option to snap the top left corner of the
box flush to grid coordinates.

ELIXIRFORM FOR AFP USER GUIDE 2-7



ELIXIRFORM BASICS

Box - Shape - Oblong/Square

Select the top half of this option to draw boxes as rec-
tangles. Select the bottom half of this option to draw
boxes as squares.

Box - Diagonals

Select the diagonal line pattern for inside the box:
[None], [Left], [Right], or [Both].

Custom Line/Border Thickness

Specify a value (in dots) by clicking on the up or down
arrows or click in the numeric display box and enter a
value (maximum 99 dots). Specify [0] to apply an in-
visible border to a shaded box. Unshaded boxes
must have a border width of [1] or higher.

You can also select: [Thin], [Medium], or [Thick] box
line widths.

Box - Line/Border Style

Select the line style: [Solid], [Dashed], or [Dotted].

Box - Border/Split Thickness and Style

Select width and style options:

® [Border Splits] - sets the width and style of the
box border

® [Horizontal Splits] - sets the width and style of the
horizontal box splits

® [Vertical Splits] - sets the width and style of the
vertical box splits
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Box - Horizontal Splits

Select this option, then click on the up or down arrows
or enter a value in the numeric display box to specify
the number of equal horizontal portions to divide the
box into. The minimum value is 1 (hollow) and the
maximum value is 40.

Select this option a second time to disable horizontal
box splits.

Box - Vertical Splits

Select this option, then click on the up or down arrows
or enter a value in the numeric display box to specify
the number of equal vertical portions to divide the box
into. The minimum value is 1 (hollow) and the maxi-
mum value is 40.

Select this option a second time to disable verticalbox
splits.

Box - Color

Select a box border color from the palette in the Color
dialog box, then click on the [Close] button. The se-
lected box color displays in the bottom half of the icon.

Box - Fill Color

Right-click to select a box fill color from the palette in
the Color dialog box, then click on the [Close] button.
The selected box fill color displays in the bottom half
of the icon.

Object Fill Pattern/Shading

Select a shade pattern from the Pattern dialog box. All
boxes you draw contain this shading until you change
it, using the same procedure. Select [Hollow] for no
shading.

Box - Corner Radius

Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a value
(maximum 299 pels).
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Circle tool

You can also select: [Small] 10 pels, [Medium] 20
pels, [Large] 30 pels, or [Maximum]. This option does
not apply when all corner styles are 90 degrees.

Draws circles and specifies circle properties. See the
"Shapes" chapter for more information on the options
described below.

Circle - Radius

Select one or more of the four circle quarters to com-
pose a circle or partial circle. Select a quarter a sec-
ond time to deselect it.

Circle - Drawing Method

Select the top half of this option to draw a circle from
its center outward, where the anchor point is the circle
center.

Select the bottom half of this option to draw a circle
within an unseen box, where the anchor point is the
box corner nearest the starting point. This method al-
lows you be more precisely place the circle in relation
to another element.

Circle - Diagonals

Select the diagonal line pattern for inside the circle:
[None], [Left], [Right], or [Both].

Only 360-degree circles display diagonals.
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Custom Line/Border Thickness

Specify a value (in dots) by clicking on the up or down
arrows or click in the numeric display box and enter a
value (maximum 99 dots). Specify [0] to apply an in-
visible border to a shaded circle. Unshaded circles
must have a border width of [1] or higher.

You can also select: [Thin], [Medium], or [Thick] bor-
der widths.

Circle - Border Style

Select the circle line style: [Solid], [Dashed], or
[Dotted].

Circle - Start and Finish Angle

Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a value
(in degrees) for where you want your circle to begin
and end.

You can also select: [0], [90], [180], or [270] degrees.

Circle - Color

Select a circle border color from the palette in the
Color dialog box, then click on the [Close] button. The
selected circle color displays in the bottom half of the
icon.

Circle - Fill Color

Right-click to select a circle fill color from the palette in
the Color dialog box, then click on the [Close] button.
The selected circle fill color displays in the bottom half
of the icon.

Object Fill Pattern/Shading

Select a shade pattern from the Pattern dialog box. All
circles you draw contain this shading until you change
it, using the same procedure. Select [Hollow] for no
shading.
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Text tool

Circle Axis

Select an axis on which to print to an AFP printer:

[None] - no axis

[Horizontal] - horizontal axis
[Vertical] - vertical axis

[Both] - horizontal and vertical axis

Select text attributes for form elements. See the "Text
operations" chapter for more information on the op-
tions described below.

Text - Direction

Select a text display direction:

[Across] - left to right
[Down] - top to bottom
[Back] - right to left
[Up] - bottom to top

Text - Inter-character/Inter-word Spacing

Select a display spacing option:

® [Inter-character] - justifies all text blocks by in-
creasing or decreasing the amount of space be-
tween characters. This makes the form easier to
read when converted to OGL, but takes longer for
the form to print.

® [Inter-word] - justifies all text blocks by increasing
or decreasing the amount of space between
words.

These options are global features. Selected options
apply to all text blocks on the form.

The [Inter-character] or [Inter-word] options apply to a
form only when you convert the .ELX file, when this is
a valid option for your conversion. See your Elixir
Desktop and Converters for AFP User Guide for more
information.
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Text - Word Wrapping

Wraps text between the boundaries set in the [Col-
umn Width] option. You can also select the [Box Text]
option and draw a visual box on your form to contain
the text. Select this option when text is justified.

Text - Remove Redundant Spaces

Removes redundant spaces, relative shifts and car-
riage returns from text blocks that have the [Text -
Word Wrapping] option selected.

Text - Split String

Splits a single block of text into two separate text
blocks.

Text - Justification

Specify the justification for each text block: [Left Justi-
fication], [Center Justification], [Right Justification], or
[Full Justification].

The [Wrap Text] and [Box Text] or [Column Width] op-
tions must be selected for text justification.

Text - Positioning

When the [Wrap Text] and [Box Text] options are se-
lected, specify the vertical positioning of a text block:
[Top], [Center], or [Bottom].

Use this option with the [Text Justification] and [Box

Text] options to place text in nine positions within the
box.

Text - Lines per Inch

Specify a vertical lines per inch (LPI) value by clicking
on the up or down arrows or click in the numeric dis-
play box and enter a number. Press and hold <Ctrl>
while clicking to increase/decrease the value by 1.0.
This value you affects the current block of text and
any subsequent blocks of text entered using the same
font.
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To return the lines per inch to the default for the cur-
rent font, use the down arrow to decrease the LPI
value to [0] or press <Del>.

Text - Lines per Inch - ON/OFF

Enables the [Text - Lines per Inch] option. Select this
option a second time to disable this feature.

Text - Text Color

Select a text color from the palette in the Color dialog
box, then click on the [Close] button. The selected
color displays in the bottom half of the icon.

DocuTag/DataMerge - Data Tags - ON/OFF

Displays the Data Tagging dialog box which allows
you to add data tags to forms for use with Elixir's
DocuTag or DataMerge products. Select this option a
second time to disable this feature.

See your Elixir DocuTag User Guide or Elixir Da-

taMerge User Guide for more information on creating
data tags and tag lists.

Text - Column Width

Specify the width for a text block by clicking on the up
or down arrows or click in the numeric display boxes
and enter a number. Press and hold <Ctrl> while
clicking to increase/decrease the value by 1.0. Values
that exceed the form limits are not accepted.

You must select the [Wrap] text option when using
these options. When these options are set to [0.00],
text entered is bound only by the width and height of
the form.

Select the [Box Text] option along with these options
to display a visual guide box with the width and height
dimensions you specify.
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Text - Draw Column Box Boundaries

Select this option after selecting the [Box Text] option
to define column boundaries for text by drawing a vis-
ual box in the Work area. Place the cursor in the
Work area and press and hold down the mouse but-
ton. Drag the box that displays and release the
mouse button at the bottom right of the box. This box
does not print.

Select the [Wrap Text] option to wrap text at the
boundary of the text box defined by this option. Select
the [Text Positioning] option to position text within the
text box.

Text - Column Height

Specify the height for a text block by clicking on the up
or down arrows or click in the numeric display boxes
and enter a number. Press and hold <Ctrl> while
clicking to increase/decrease the value by 1.0. Values
that exceed the form limits are not accepted.

You must select the [Wrap Text] option when using
these options. When these options are set to [0.00],
text entered is bound only by the width and height of
the form.

Text - Set Column Width/Height to Define Box -
ON/OFF

Select this option when using the [Draw Text Box] or
[Column Width] and [Column Height] options to enter
text in predefined areas or "boxes." Select this option
a second time to enter free text which is bound only by
the width and height of the form.

Box boundaries are defined by entering values in the
[Column Width] and [Column Height] options or by
drawing a box manually using the [Draw Text Box]
option.

Font Type

Click on this button until the desired font type displays:

® [f] - Elixir-version fonts
® [T]- True Type fonts
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® [a]- ATM fonts

Text - Add/Remove Font from List

Select a font action. The dialog box that displays de-
pends on your selection in the [Font Type] option.

e [+] - displays the Add Fonts, Select True Type
fonts, or Select ATM fonts dialog box; select a
font(s) to add to the current Font List, then click
on the [ADD] button

e [-] - displays the Replace Font, Select True Type
Fonts, or Select ATM Fonts dialog box; select a
font(s) to remove from the current Font List, then
click on the [DEL] button. If the font is in use on
the form, select a replacement font from the Re-
place Font dialog box.

Text - Load Font List/Merge Font List/Save Font
List

Select a Font List action:

® [down arrow] - displays the Load Font List dialog
box

® [double arrows] - displays the Merge Font List dia-
log box; add fonts to the current Font List by load-
ing another Font List

® [up arrow] - displays the Save Font List dialog

box; enter a new file name for the current font list,
or rename an existing font list

Text - Soft Keyboard

Enters characters that are not available on a standard
keyboard. See the "Text operations" chapter for more
information on using the soft keyboard.

Font Preview Panel

Displays the fonts available in the current Font List.
Click on the up or down arrow or use the scroll bar to
scroll through the list to change the current font.
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Image tool

Fonts in use on a form are denoted by a diamond
character to the left of the font name.

Adds Elixir-format screen (.LP3) or printer (.LW8) im-
ages, bitmaps (.BMP), or logos to a form. See the "Im-
ages" chapter for more information on the options
described below.

Image - Name

Displays the name of the selected image.

Image - Size
Horizontal/Vertical

Displays the horizontal and vertical sizes of the image
in the units selected in the Ruler in the Toolbar. See
the "Toolbar" section for more information.

Image - Color

Select an image border color from the palette in the
Color dialog box, then click on the [Close] button. The
selected image color displays in the bottom half of the
icon.

Image - Fill Color

Right-click to select an image fill color from the palette
in the Color dialog box, then click on the [Close] but-
ton. The selected image fill color displays in the bot-
tom half of the icon.

Image - Load

Select an image to add to your form from the Load Im-
age dialog box.
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Toolbar

I

Current object - Shape

0.00 ] 3.28 0.52
|-|g 217 |: 017 IElnches

The Toolbar displays across the top of the Work area

and contains the following options:

Current object - Dimensions

Spell Check

Long Crosshair
Grid Display
|

Digital ruler

T
Digital Ruler

Current object - Snap to Grid Show/hide
Start Coordinates . Zoom Toolbox
Graphic Ruler  in/out
Undo/Redo

Figure 2-3. Toolbar

Displays the horizontal and vertical position of the
screen pointer relative to the top left corner of the
screen (0,0).

Current object - Shape

Displays an icon representing the element type the
cursor is currently closest to.

Current object - Start Coordinates

Displays the x,y coordinates of the currently selected
element.

Current object - Dimensions

Displays the width and height of the currently selected
element.
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Graphic ruler <F3>

The graphic ruler displays along the top and left edges
of the Work area in the units selected in the [Ruler
measure] option.

To display the graphic ruler either:

® click on the Toolbar Graphic Ruler
® select [Ruler] from the View menu

A check mark appears in the menu next to the se-
lected option.

Select this option a second time to remove the graphic
ruler.

Right-click on the Ruler in the Toolbar to display the
Ruler Options dialog box.

Grid Display <F4>

The grid helps you place and align form and data ele-
ments accurately. It overlays the Work area to allow
exact placement of elements, but does not print.

To display the grid in your Work area either:

® click on the Toolbar Grid Display icon

® press <F4>

® select [Grid] from the View menu

A check mark appears in the View menu next to the
selected option.

Select this option a second time to remove the grid.

Right-click on the Toolbar Grid Display icon to display
the Grid Setting dialog box.

Snap to Grid <F5>

Places elements accurately on the grid.
To use the snap to grid option either:

® click on the Toolbar Snap to Grid icon
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® press <F5>
e select [Snap to Grid] from the Options menu

Select this option a second time to disable this feature
- elements become free floating and are moveable
anywhere on the screen.

Right-click on the Toolbar Grid icon to display the Grid
Setting dialog box.

Long Crosshair <F6>

Zoom in/out

Displays horizontally and vertically from the cursor on
the form, and helps you place elements on the form
more precisely.

To display the long crosshair:

® click on the Toolbar Long Crosshair icon
® press <F6>
® select [Long Crosshair] from the View menu

A check mark appears next to the option in the menu
when it is selected. Select this option a second time
to remove the long crosshair.

Undo/Redo

To zoom in on (magnify) an area of the Work area,
click on the [+] button on the right side of the Zoom
icon in the Toolbar. The highest magnification is [8x].

To zoom out on (reduce the magnification of) an area
of the Work area, click on the [-] button on the left side
of the Zoom icon in the Toolbar. The lowest reduction
is [-8x].

You can also use the <+> and <-> keys on the nu-
meric keyboard to zoom in and out.

To cancel your most recent operation:

® click on the Toolbar Undo icon
® press <Ctrl> + <Z>
® select [Undo] from the Edit menu
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Spell Check

To cancel your most recent Undo operation:

e click on the Toolbar Redo icon
® press <Shift> + <Ctrl> + <Z>
® select [Redo] from the Edit menu

Checks the spelling of the active form. See the "Text
operations" chapter for more information.

Show/hide Toolbox

Hides the Toolbox.

To redisplay the Toolbox:

® click on this icon a second time

® press <F10>

® select [Toolbox] from the Window menu

User preferences are described in the "ElixirForm de-
faults" chapter.

Menu bars

ElixirForm provides two menu bars for accessing
options:

®  ElixirForm menu bar
® \Work area menu bar

Select a menu to display its options, then select an
option from the pull-down menu.

See the "Menu bars" chapter for more details and
information.
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Creating a form

Following are suggestions you should consider when
creating a form.

Designing a new form

Sketching the form on paper before drawing it on the
screen makes element sizing and placement easier.

Reproducing an existing form

If you are creating a form from an existing form, have
the original form in front of you as you are recreating it
on the screen. Use a ruler to measure the margins,
lines and other form elements, then use the on-screen
rulers for precise placement of each element.

You can also use Elixir's ElixirScan product to scan an

existing form for conversion to Elixir format, then edit
the form using ElixirForm.

Designing a form to fit in a window envelope

If you are designing a form to fit a window envelope,
first sketch it, fold it and measure it against the enve-
lope window to ensure proper display.

Designing a form for merged data

If your form will subsequently be merged with variable
data, print the formatted data to see how it prints on
the page; it is easier to design a form around data
than to redesign the form.

Loading a form

ElixirForm allows you load a new or previously saved
form, or to merge form groups to create a new form.
Only one form at a time can be loaded into ElixirForm.
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Loading a new form <F9 >

To load a new form:
1. Select [New Form] from the File menu.
The Page Properties dialog box displays.

See the "ElixirForm defaults" chapter for informa-
tion on the Page Properties dialog box.

2. Select page defaults, then click on [OK].
The Page Databasing dialog box displays.

For information on the Page Databasing dialog
box, see the "ElixirForm defaults" chapter.

3. Enter optional information for the new form,
then click on [OK].

A new, untitled form displays in the work area.

Loading a saved form <F8 >

If you are loading a form that was created in a GEM
version of ElixirForm, see "Loading GEM forms" in this
section before loading the form.
To load a previously saved form:
1. Select [Load Form] from the File menu.
The Load Form dialog box displays.
2. Select the form to load, then click on [OK].
The form displays in the Work area.
If a referenced image is missing, a replacement im-

age displays. To delete the image from the form, se-
lect the replacement image then press <Del>.
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Merging a form

Loading GEM forms

For forms created with ElixirForm prior to version 3.0,
you can either maintain the original boxed text format-
ting or use the new Windows box text formatting. You
can also either maintain the original color mode or se-
lect a new color mode.

®  For the currently loaded GEM form only, select
text formatting and color mode options using the
Text and Fonts options dialog box and the Page
Properties dialog box.

® For all subsequently loaded GEM forms, select
text formatting and color mode options using the
GEM Forms Load Defaults dialog box.

See the "ElixirForm defaults" chapter for information

about GEM Forms Load Defaults, Text and Font Op-
tions and Page Properties dialog boxes.

group

ElixirForm allows you to merge a form into the current
work area without replacing work area contents. See
the "Grouping elements" section in this chapter for
more information about saving a form group.

ElixirForm only merges objects that fit within form
boundaries. Before using the [Merge Form Group]
option, ensure that there is sufficient work area space
available to prevent the elements from overlapping or
falling outside form boundaries.

To merge a form group:

1. Select [Merge Form Group] from the File
menu.

The Load Form Group dialog box displays.

2. Select the form to merge, then click on [OK].
Although ElixirForm allows you to merge the cur-
rently loaded form with the same form, this is not

recommended as form elements may overlap.

You cannot undo a [Merge Form Group] operation.
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Loading a form template

A form template is an .ELX form file that is loaded as
an overlay or visual guide for designing a new form.
The template does not become a part of the new
form; only the new form elements are saved.

You can load more than one form file template into the
Work area, although retrieving multiple form tem-
plates requires appreciably more memory.
Proof-printing a form comprising one or more tem-
plates also prints the templates. To proof- print a form
without the templates, save and reload the form with-
out the templates, then proof-print the reloaded form.
To load a form template:

1. Select [Load Form Template] from the File
menu.

The Load Form Template dialog box displays.

2. Select the template to use, then click on [OK].

Selecting template defaults

To select form template defaults:

1. Select [Template Options] from the Options
menu.

The Template Options dialog box displays.
2. Select display defaults, then click on [OK].

The Template Options dialog box contains the follow-
ing options:

Color
Select a display color for the template from the drop-
down list.

Object Filters

Select the form object(s) to display: [Show Lines],
[Show Boxes], [Show texts], [Show Images], [Show
Circles], or [Show Paths].
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Disable template object selection
Prevents form template objects from being selected or
modified.

Lock template
Keeps the current template loaded at all times.

Adding form elements

You create forms in ElixirForm by adding elements
such as lines, paths, boxes, circles, text and images.
You can apply different attributes to any form element
by selecting options from the Toolbox. Elements can
be placed anywhere on the form.

If you need to modify an element that is already on the
form, right-click on the element and apply new proper-
ties using options in the Toolbox.

For detailed information about adding or modifying a

form element, see the "Lines", "Shapes", "Text opera-
tions" or "Images" chapters.

Using color

Form color usage depends upon the color mode of
the printer you use for final printing. You must select
ElixirForm's color mode before creating a form. This
ensures that only the colors available on your printer
are used.

To select form color mode:

1. Select [Page Properties] from the Options
menu.

The Page Properties dialog box displays. See the
"ElixirForm defaults" chapter for more informa-
tion.

2. Select the color mode, then click on [OK].
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Saving a form with a new name

To save an existing form either with a different name
or to another directory:

1. Select [Save Form As] from the File menu.
The Save Form As dialog box displays.

2. Enter information, then click on [OK].

Saving a new form

To save a new form;
1. Select [Save Form] from the File menu.

The Save Form dialog box (similar to previous fig-
ure) displays.

2. Enter a file name, then click on [OK].

If you plan to convert the form to a different for-
mat, save the form with a maximum six-letter file
name; longer file names truncate upon conver-
sion and can overwrite existing files.

Modifying a form

You can update previously-created forms or make a
new one by modifying the form and saving it with a
new name.

Editing elements

ElixirForm allows you to edit individual elements by
moving, copying or deleting form elements, and by
changing element properties.
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® To move, copy or delete an element, right-click on
the element to select it, then perform the desired
operation.

® To change the properties of an element, double
right-click on the element and make the changes
desired.

Editing procedures are similar for lines, paths, boxes,
circles, images and text, as described in later
chapters.

Shifting elements

You can shift all or selected elements on a form. It is
easier to see the elements shifting if you first select
the grid option.

To shift form elements, hold down the <Ctrl> key and
use the arrow keys to shift elements up, down, left or
right. You can also shift elements using the direction
keys on the numeric keypad by first pressing <Num
Lock>.

Grouping elements

ElixirForm groups form elements for editing purposes.
Once a group is defined, you can edit it like a single
form element.

ElixirForm undoes a group one element at a time. For
example, if you delete a group and then click on the
Undo icon, the elements comprising the group reap-
pear one at a time.

Defining a group

To define a group:
1. Select the Select/Edit tool in the Toolbox.

2. Move the screen pointer near the elements
you want to group.
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3. Click and drag the dotted line until it encloses
the desired elements, then release the mouse
button.

Boxes appear around or inside each grouped ele-
ment. Grouped text appears in square brackets.

Figure 2-4. Selected group elements

Move, copy or delete the group as a single
element.

To change the properties of one or more grouped
elements, right-click on the element(s) and select
desired properties from the Tool box.

You can also exclude any or all occurrences of a
grouped element:

« To exclude all occurrences of an element,
select a group filter option before grouping.

« Toexclude any one element from the group,
shift-click on the element after grouping.

« To include the element again, shift-click on
the element a second time.
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Saving a form group

ElixirForm allows you to select a group in an existing
form and save it as a separate form file. You can then
edit the file, or use it as a template for other forms.

This feature is helpful for reusing standard elements
such as headers and footers in other forms. You can
also merge selected elements from different forms to
create another form. See the "Merging a form group"
section in this chapter.
To save a form group:

1. Define the group as described in the above
section.

2. Select [Save Form Group] from the File menu.

3. Enter a filename in the dialog box, then click
on [OK].

The form group saves to the forms directory
specified.

Undo/redo feature

ElixirForm allows you to undo or redo an operation.

To cancel your most recent operation:

m| ® click on the Toolbar Undo icon
® press <Ctrl> + <Z>
® select [Undo] from the Edit menu

To cancel your most recent Undo operation:

e click on the Toolbar Redo icon
a ®  press <Shift> + <Ctrl> + <Z>
® select [Redo] from the Edit menu

When you cancel a group operation, ElixirForm un-
does the operation one element at a time.
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Deleting a form

To delete a form:

1. Select [Delete Form] from the File menu.
The Delete Form dialog box displays.

2. Select the name of the form to delete, then
click on [OK]

The form deletes.

Renaming or moving a form

To rename or move a form;

1. Select [Rename/Move form] from the File
menu.

The Rename/Move Form dialog box displays.

2. Select the form you want to rename/move,
then click on [OK]

A supplemental dialog box displays the directory
and name of the form.

Targel directory doesn't exist.

From: CAELIXIAN\FORMSAELIXIR\DEMODATAX ELX

To:  |CAELIKIBAFORMSAELIXIBADEMOABOND ELX

Figure 2-5. Rename/Move Form dialog box

3. Enter a new directory name or a new file
name, then click on [OK].

The form must have an .ELX extension to load
into ElixirForm.
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Proof printing a form

To proof print a form:

1. Pull down the File menu and select [Print].

The Print dialog box displays.

Printer:

Orientation Page Shift

ELIXIR HF driver on LPT1:
HP Laserdet I115i on LPT1:

PostScript Printer on LPT1:

| Set Elixir HP Driver as default printer

“+ Portrait Zshift: D Meszage...
 Landscape Yshift: |0

Setup
LCopies: I:I
| Print to File V oK
Print Fonts
_ | as Graphic
xﬁancel

Figure 2-6. Print dialog box

Select/enter printer information, then click on
[OK].

If printing to a file, enter a file name, then click
on [OK].

ElixirForm creates a print file with a .PRN exten-
sion in the drive\ELIXIR\PRINTS\HPPRINT
subdirectory.

To print a form that has been written to disk, exit
ElixirForm and display the DOS prompt. Specify
the directory of the print file, and use the DOS
COPY command to copy the .PRN file to your ac-
tive parallel port (for example, LPT1).

COPY filename.PRN LPT1 <Enter>
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where filename is the stem name of the disk file.

Use the COPY/B command when printing HP
PCL files from disk.

The Print dialog box contains the following options:

Printer
Select a PCL 4 or compatible printer based on the fol-
lowing considerations.

e  Elixir HP Driver
Provides optimal Elixir form proof-printing, includ-
ing increased printing speed and the ability to
print shaded boxes using HP printer shading
calls, store a form as a macro and call printer-
resident fonts.

e PCL4
PCL 4 printers print a maximum page size of 8 x
10.33 inches. If your form boundaries fill an 8.5 x
11 inches page, the outer margins of your form
will not print on a PCL 4 printer.

For accurate positioning, shift the print image on
the page using the [Page Shift] option.

®* PDF format
If you installed Adobe's PDFWriter printer driver
on your PC, you can convert your form to PDF
format by selecting [PDF ON FILE:] from this win-
dow. You are then prompted for a directory and
file name.

Set Elixir HP Driver as default printer
Sets the Elixir HP Driver as the default printer.

Orientation
Select form print orientation; [Landscape] or [Portrait].

Page shift
Enter the number of dots to shift your printer output
horizontally or vertically:

® [Xshift] - image moves horizontally
® [Yshift] - image moves vertically
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Use a negative shift value to shift the print output to
the left, or up; and a positive value to shift your print
output right, or down.

Copies
The number of print copies.

Print to file

Prints your file to disk for proof-printing. To print a
form to a disk file for proof-printing, all proof printer
versions of fonts used in the form must reside on the
proof printer. Click on [OK], then enter the path and
file name in the Print to File dialog box.

Autogen Output Name
ElixirForm automatically names your file.

Print Fonts as Graphic

Rasterizes fonts as graphics. Printing fonts as graph-
ics requires less printer memory, speeding up printing
time.

Load Fonts
Select one of the following font load options:

* JAlways] - downloads fonts every time form
printed

® [Once] - downloads fonts as soft fonts identified
by index number; fonts then managed by and ac-
cessed through the Windows Control Panel

®* [Never] - calls the index number of soft fonts re-
siding on printer; no new font are downloaded

If you select [Once] or [Never], make sure to use the
same font list in your form as on the printer; if not, the
index number may represent a different font.
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Editing multiple forms

ElixirForm allows you to group multiple form files to-
gether for editing with the document editing feature.
An Elixir document is a group of Elixir forms (.ELX)
referenced in a text file with a .DAT extension and re-
sides in the Elixir Documents folder.

Elixir document files are created/edited with any stan-

dard text editor or with the Elixir Desktop. See your

Elixir Desktop for AFP User Guide for more

information.

To load a .DAT file:

1. Select [Open DAT File] from the File menu.
The Open Dat File dialog box displays.

2. Select the document to open, then click on
[OK].

To select .DAT file form(s) to edit:
1. Select [Load Form] from the File menu.

The Load Forms from Dat File dialog box
displays.

2. Select the form(s) to edit, then click on [OK].

Select [Merge Form Group] from the File menu to
merge pages/forms on top of the currently loaded
form. Select the form(s) to merge, then click on
[OK].

Select [Close DAT File] from the File menu to re-
turn to single page/form loading mode. Select
[Filing Options] from the System menus to set the
default directory for .DAT files.
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Fast keys

Fast keys are available for many ElixirForm opera-
tions. ElixirForm fast keys display next to options in
pull-down menus. See the "Keyboard shortcuts" ap-
pendix for a complete listing.

Exiting ElixirForm

To exit ElixirForm and return to the Desktop either:

press <Alt> + <F4>

® select [Exit] from the File menu

® double-click on the [Close] button (the top left cor-
ner of the screen)
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This chapter provides information on the ElixirForm
and Work area menu bars.

ElixirForm menu bar

File menu

The ElixirForm menu bar contains the File, System,
Window, and Help menus. Select a menu to display
its options, then select an option from the pull-down
menu.

The File menu contains the following options:

New Form <F9>

Select form defaults in the Page Properties dialog
box. See the "ElixirForm Defaults" chapter for more
information on the Page Properties dialog box.

Load Form <F8>

Select an existing form to open in the Load Form dia-
log box.

Save Form <Ctrl> + <S>

Saves your open form under the original name speci-
fied in the Page Properties dialog box. See the "Elixir-
Form Defaults" chapter for more information on the
Page Properties dialog box.

For a form being saved for the first time, enter a name
in the Save Form As dialog box.
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Save Form As <F7>

Enter a new file name to save the open form under in
the Save Form As dialog box.

Rename/Move Form

Rename and/or change the path of an existing form in
the Rename/Move Form dialog box.

Delete Form

Select a form to delete in the Delete Form dialog box.

Merge Form Group

Select a group to add to the current form in the Load
Form Group dialog box. See the "ElixirForm basics"
chapter for more information on form groups.

Save Form Group

Select a group on an existing form to save as a form
file in the Save Form Group dialog box.

Load Form Template

Select a form template to load onto the current form in
the Load Form Template dialog box. The template is
only a visual guide for designing new form elements
around. It does not become part of the form when the
form is saved.

Proof printing a form that includes one or more tem-
plates also prints the templates. If you want to proof
print a form without the templates, save and reload
the form without the templates, then proof print the re-
loaded form. See the "ElixirForm basics" chapter for
more information on loading form templates.

Remove Form Template

Removes all templates from the current form.
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System menu

Open Dat File

Select the .DAT file to open in the Open Dat File dia-
log box. A .DAT file is a group of Elixir forms (.ELX)
referenced in a text file with a .DAT extension.

See the "ElixirForm basics" chapter for more informa-
tion on editing multiple forms.

Close Dat File

Closes the open .DAT file.

Import Text

Select text to import into the current form in the Import
Text dialog box. See the "Text operations" chapter for
more information on importing text.

Print

Select form printing defaults in the Print dialog box.
See the "ElixirForm basics" chapter for more informa-
tion on printing.

Exit

Exits the current ElixirForm session.

The System menu contains the following options:

Usage Switches

Select display defaults in the Usage Switches dialog
box. See the "ElixirForm defaults" chapter for more
information on the Usage Switches dialog box.

Filing Options

Select filing defaults in the Filing Options dialog box.
See the "ElixirForm defaults" chapter for more infor-
mation on the Usage Switches dialog box.
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Window menu

Reset to Defaults

Resets all Toolbox options to their default values.

Save Configuration

Saves the current ElixirForm session configuration in
the  drive:\ELIXIR\DESKTOP\SYSTEM\JOBDES.INI
and drive:\ELIXIR\DESKTOP\SYSTEM\FBW.INI files.

Help menu

The Window menu contains the following options. A
check mark appears in the menu next to the selected
option.

Tile

Maximizes all open windows, with the Toolbox display-
ing to the left of the Work area.

Form <Ctrl> + <F4>

Displays the Toolbar, Work area, and Work area
menu bar. Select this option a second time to hide
these features.

Toolbox <F10>

Displays the Toolbox. Select this option a second
time to hide the Toolbox. See the 'ElixirForm basics"
chapter for more information on the Toolbox.

Displays on-line Help for ElixirForm’s windows, dialog
boxes and operations. Help is also available by click-
ing on a dialog box’s [Help] button. See the "Introduc-
tion" chapter for more information on on-line help.
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Work area menu bar

Edit menu

The Work area menu bar contains the Edit, Tools,
View, and Options menus. Select a menu to display
its options, then select an option from the pull-down
menu.

The Edit menu contains the following options.

Undo <Ctrl> + <Z>

Cancels the most recent action performed.

Redo <Shift> + <Ctrl> + <Z>

Cancels the most recent Undo operation.

Cut <Ctrl> + <X>

Moves the selected text to the Windows Clipboard.

Copy <Ctrl> + <C>

Copies the selected text to the Windows Clipboard.

Paste <Ctrl> + <V>

Inserts cut or copied text from the Windows Clipboard.

Select All <Ctrl> + <A>

Selects all elements on the current form. This allows
you to delete, copy, or move the elements.

Deselect All <Ctrl> + <A>

Deselects all previously-selected elements.
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Tools menu

Delete <Del>

Deletes the selected element(s) from a form.

Delete All <Ctrl> + <Del>

Deletes all selected elements from a form.

Find <Alt> + <F3>

Enter the text string to search the open form for in the
Find text dialog box. See the "Text operations" chap-
ter for more information on the Find text dialog box.

Find Next <F3>

Finds the next occurrence of the text string entered in
the Find text dialog box. See the "Text operations"
chapter for more information on the Find text dialog
box.

Find Previous <Shift> + <F3>

Finds the previous occurrence of the text string en-
tered in the Find text dialog box. See the "Text opera-
tions" chapter for more information on the Find text
dialog box.

Replace

Enter the text to search for and the text which re-
places it in the Replace Text dialog box. See the
"Text operations" chapter for more information on the
Replace text dialog box.

The options in this menu provide an alternate way to
activate the Toolbox or Toolbar for the tool selected:
Select, Line, Path, Box, Circle, Text, and Image. The
currently selected Toolbox or Toolbar displays with a
check.

Spell Check

Checks the spelling in the active form.
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View menu

Options menu

The options in this menu provide an alternate way to
activate the Toolbar options: Ruler, Grid, and Long
Crosshair.

The Options menu contains the following options:

Snap to Grid <F5>

Forces placement of lines, paths and boxes to the
grid.

GEM Forms Load Defaults

For forms created using Elixir's ElixirForm product
prior to version 3.0, select GEM form display defaults
in the GEM Forms Load Defaults dialog box. See the
"ElixirForm defaults" chapter for more information on
the GEM Forms Load Defaults dialog box.

Page Properties

Select page defaults in the Page Properties dialog
box. See the "ElixirForm defaults" chapter for infor-
mation on the Page Properties dialog box.

Page Databasing

Select page databasing defaults in the Page Databas-
ing dialog box.

Page databasing places form documentation informa-
tion on a form and stores with the form until it is
changed or deleted. It does not print.

See the "ElixirForm defaults" chapter for more infor-
mation on the Page Databasing dialog box.
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Text/Font Options

Select text and font defaults in the Text and Font Op-
tions dialog box. See the "ElixirForm defaults" chap-
ter for more information on the Text and Font Options
dialog box.

Character Mapping

Select keyboard-entered, imported text, or spell
checker character mapping options in the Character
Mapping Options dialog box.

The Character Mapping dialog box contains the fol-
lowing options:

Keyboard Mapping
Select an option for mapping characters entered via
the keyboard:

®* [None] - use Windows ANSI mapping; select this
option if you work with ATM or True Type fonts

* |[OEM] - remaps ANSI keystrokes to DOS
mappings

® [OEM/ISO] - remaps ANSI character strokes to
DOS ISO mappings

® [KMP] - translates keystrokes using customized
tables

When you select [KMP], the [Windows] and [Elixir] op-
tions display:

Windows

Select the character map for the current keyboard
layout from the drop-down list. Most users should
select TIOOANSI. If you are using an Eastern
European version of Windows, you should select
T10EEURO.

Elixir

Select the setting that matches your DOS code
page from the drop-down list. This is the charac-
ter map used by Elixir fonts. To check your DOS
code page, go to the DOS prompt and type:

CHCP <Enter>
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The active code page displays.

Text Import Mapping

Select a translation option for characters imported
from an external text file. All mappings (except when
[KMP] is selected) translate to the standard Windows
character set.

®* [NONE] - when importing or pasting a Windows
text file

e [OEM] - when importing or pasting a DOS text file

e [OEM/ISO] - when importing a DOS text file from
a non-US DOS environment

® [ISO] - when importing or pasting a DOS text file
that has mapped European characters

® [KMP] - uses custom translation tables:

When you select [KMP], the [Text File] and [Elixir] op-
tions display:

Text File
Select the source text file's character map from
the drop-down list.

Elixir

Select translation character map for the target
text from the drop-down list. To check your DOS
code page, go to the DOS prompt and type:

CHCP <Enter>

The active code page displays.
Text Paste Mapping
Select a translation option for characters imported
from an external text file. All mappings (except when
[KMP] is selected) translate to the standard Windows
character set.

®* [NONE] - when importing or pasting a Windows
text file

® [OEM] - when importing or pasting a DOS text file
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[OEM/I1SQ] - when importing a DOS text file from
a non-US DOS environment

[1SO] - when importing or pasting a DOS text file
that has mapped European characters

[KMP] - uses custom translation tables:

When you select [KMP], the [Text] and [Elixir] options
display:

Text
Select the source text file's character map from
the drop-down list.

Elixir

Select translation character map for the target
text from the drop-down list. To check your DOS
code page, go to the DOS prompt and type:
CHCP <Enter>

The active code page displays.

Spell Checker Mapping
Select a spell checker character mapping option:

[None] - use Windows ANSI mapping; select this
option if you work with ATM or True Type fonts

[OEM] - remaps ANSI characters to DOS
mappings

[OEM/ISQ] - remaps ANSI characters to DOS
ISO mappings

[KMP] - translates keystrokes using customized
tables

When you select [KMP], the [Windows] and [Elixir] op-
tions display:

Windows

Select the Windows character map from the drop-
down list. Most users should select TI00ANSI. If
you are using an Eastern European version of
Windows, you should select TLOEEURO.
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Elixir

Select the setting that matches the mapping of
the Elixir fonts used in the form currently being
spell checked.

Spell Check Options

Select spell checking defaults in the Spell Check Op-
tions dialog box. See the "Text operations" chapter
for more information on the Spell Checker.

Template Options

Select form template defaults in the Template Options
dialog box. See the "ElixirForm basics" chapter for
more information on the Template Options dialog box.

ELIXIRFORM FOR AFP USER GUIDE 3-11



4, ElixirForm defaults

This chapter contains procedures for setting Elixir-
Form defaults. Although you can change settings for
each form, you will probably find that you can keep the
same defaults for most of your forms.

User preferences

Grid <F4 >

This section describes the Toolbar grid, rulers and
long crosshair options. These options are used to ob-
tain precise form element measurement and place-
ment within the Work area.

ol

The grid helps you place and align form and data ele-
ments accurately. It overlays the Work area to allow
exact placement of elements, but does not print.

Displaying/hiding the grid

To display the grid in your Work area either:
® click on the Toolbar Grid Display icon

® press <F4>

® select [Grid] from the View menu

A check mark appears in the View menu next to the
selected option.

Select this option a second time to remove the grid.

Right-click on the Toolbar Grid Display icon to display
the Grid Setting dialog box.

ELIXIRFORM FOR AFP USER GUIDE 4-1



ELIXIRFORM DEFAULTS

Selecting grid properties

To select grid properties:

1. Right-click on the Grid icon in the Toolbar.

The Grid Setting dialog box displays.

I Grid Setting I

Grid units: per 1 Inch

Gridstep: [5]010] [ 007 ]

in 1/100 of Inch

_ | Graphic Ruler in Grid Units

[ Inches | CM|[" MM| Dots ][ Paints ] Pels |

__| Digital Ruler in Grid Units

Gnd Snap to: Gnid Color: Snap mouse speed: V Ok
“+ Full Grid “# Black  Slow

> Half Grid > Dark Shade | * Moderate x[:anc:el
 Green > Fast

_ | Show Grid _| Snap to Grid ? Help

Figure 4-1. Grid Setting dialog box
2. Select/enter grid options, then click on [OK].

The Grid Setting dialog box contains the following op-
tions. Fields in this dialog box may or may not display,
depending on the options selected.

Grid units
Enter the number of grid units displayed per unit of
measure. Default is 10 x 6 grid units per inch.

Grid step
Enter a grid step value to define the distance between
grid points.

Grid units and Grid step units of measure are defined
by your selection in the [Ruler measure] option. The
size of the grid units or grid step dimensions entered
above are maintained, even though the value may
change based upon the current unit of measure.

42

ELIXIR TECHNOLOGIES CORPORATION



ELIXIRFORM DEFAULTS

You can enter grid dimensions using either the [Grid
units] or [Grid step] options, but not both.

Ruler measure

Select the unit of measure for display: [Inches], [CM],
[MM], [Dots], [Points], or [Pels]. Your selection also
changes the [Ruler measure] option in the Ruler Op-
tions and Page Properties dialog boxes.

Graphic Ruler in Grid Units
The graphic ruler reflects the values specified in the
[Grid units] option.

For example, if the [Grid units] option is set to 8.00 per
1 inch for the horizontal setting and 6.00 per 1 inch for
the vertical setting, the horizontal graphic ruler dis-
plays 8 divisions (grid units) per inch and the vertical
graphic ruler displays 6 divisions (grid units) per inch.

Digital Ruler in Grid Units
The digital ruler reflects the values specified in the
[Grid units] option.

See the [Graphic Ruler in Grid Units] option for an
example.

Grid Snap to
Select a snap to option:

® [Full Grid] - form elements snap to grid points

® [Half Grid] - form elements snap to grid points
and to points halfway between grid points

In both instances, all elements resize to fit the grid.

Grid Color
Select the grid color: [Black], [Dark Shade], or
[Green].

Snap mouse speed
Select the mouse’s snap speed: [Slow], [Moderate], or
[Fast].

Show Grid
Displays the grid in the Work area. Select this option
a second time to remove the grid.
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Rulers <F3>

Snap to Grid
Form elements snap to full grid or half grid points.

You can also select the Snap to Grid feature by click-
ing on the Snap to Grid icon in the Toolbar or by pull-
ing down the Options menu and selecting [Snhap to
Grid]. See the "Snapping elements to the Grid" sec-
tion in this chapter for more information.

E Inches

The ElixirForm toolbar contains two rulers:

®  Graphic ruler
e Digital ruler

Graphic ruler

To display the graphic ruler either:

® click on the Ruler icon in the Toolbar
® select [Ruler] from the View menu

A check mark appears next to the option in the
View menu when selected.

Digital ruler

The digital ruler displays the horizontal and vertical po-
sition of the screen pointer.

When [Snap to Grid] is selected, the digital ruler
shows only the coordinates of the grid points nearest
to the screen pointer.

To display the position of an element relative to the
form, select the Select/Edit tool and move the cursor
to any area on the element. A second digital ruler dis-
plays in the Toolbar, displaying the horizontal and ver-
tical start coordinates of the element. A third digital
ruler shows element width and depth.

Rulers not part of the saved or printed form.
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To select graphic ruler options:
1. Right-click on the Ruler icon.

The Ruler Options dialog box displays.

I Huler Options I

|Ruler meazure |[Ruler color
> Dots “* Light Gray
 Points + Dark Gray
- Pels > Green

| Graphic ruler | in Grid Units

+| Digital ruler | in Grid Units / O xl:ancel ? Help

Figure 4-2. Ruler Options dialog box
2. Select display options, then click on [OK].

The Ruler Options dialog box contains the following
options:

Ruler measure

Select the display unit of measure: [Inches], [CM],
[MM], [Dots], [Points] or [Pels]. Your selection also
changes the [Ruler measure] option in the Grid Set-
ting and Page Properties dialog boxes.

Ruler color
Select the ruler color: [Light Gray] (may be [White] on
some monitors), [Dark Gray] or [Green].

Graphic ruler <F3 >
Displays the graphic ruler along the top and left edges
of the Work area.

Digital ruler
Displays the position of the screen pointer relative to
the top left corner of the Work area (0,0).

in Grid Units

Displays the corresponding ruler in the units of meas-
ure entered in the [Grid Units] option in the Grid Set-
ting dialog box.
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Long crosshair <F6 >

=

The long crosshair helps you to more precisely place
form elements about the work area.

To use the long crosshair:

1. Click on the Long Crosshair icon in the
Toolbar.

2. Place cursor onto the desired location in
Work area.

The long cross hair displays vertically and hori-
zontally from the cursor.

Zoom in/out
The zoom in feature allows you to move about the
form in magnified view:
=
35
Figure 4-3. Magnified view
j| T To zoom in on (magnify) an area of the Work area,
hal (B click on the [+] button on the right side of the Zoom

icon in the Toolbar. The highest magnification is [8x].

To zoom out on (reduce the magnification of) an area
of the Work area, click on the [-] button on the left side
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of the Zoom icon in the Toolbar. The lowest reduction
is [-8X].

You can also use the <+> and <-> keys on the nu-
meric keyboard to zoom in and out.

Keyboard zoom in/out controls

ElixirForm support the following keys strokes for
zooming infout:

<+> (numeric keypad) to zoom in

<-> (numeric keypad) to zoom out

arrow keys to pan form about the screen
<Home> to pan to the top left of the form
<End> to pan to the bottom left of the form
<Ctrl> + <PgDn> to pan to bottom right of form
<Ctrl> + <PgUp> to pan to top right of form
<PgUp> to scroll up

<PgDn> to scroll down.

Page settings

This section describes procedures for setting form
page default values.

Selecting page properties

The Page Properties dialog box displays when a new
form loads.
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To change displayed default values:

1. Select [Page Properties] from the Options
menu.

The Page Properties dialog box displays.

I Page Properties I

|
|<» 85x11] 85x14| 11x17 || A4 | A3][_ Custom |
B ] B mches

‘ [*_Inches | CM][_ MM][_ Dots | Points|[_ Pels |

Color Mode: [ - Black & White|[ - High#ight Tolor|[+ Full Color [ ¥BF s |

Page Offset:
Hoffset 0.00

Inches V x ?
Yoffset: | 0.00 0K Cancel Help

Figure 4-4. Page Properties dialog box

2. Select/enter default values, then click on [OK].

The Page Properties dialog box contains the following
options:

Page size

Select the overlay’s page size. The width and length of
the page display below this field in the units of meas-
urement specified in the Units of Measure field.

[8.5 x 11] - U.S. letter size

[8.5 x 14] - U.S. Legal size

[11x17]-11x 17 inches

[A4] - 8.27 x 11.69 inches

[A3] - 11.69 x 16.54 inches

[Custom] - nonstandard size; enter a width and
height (maximum 17 inches x 17 inches)
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If you change the page size of an existing form, some
form elements may extend beyond the page bound-
ary. If this happens, the Objects Off Page dialog box
displays when you click on [OK]. See the "Exceeding
form page size limits" section for more information on
the Objects Off Page dialog box.

Switch
Changes the page orientation by reversing the width
and height of the page.

Units of measure

Select the unit of measurement for the graphic and
digital rulers and the selected page: [Inches], [CM],
[MM], [Dots], [Points], or [Pels].

Your selection also changes the Ruler measure option
in the Ruler Options and Grid Settings dialog boxes.

Color mode
Select the color mode supported by your output
printer:

® [Black and White] - the Color options do not dis-
play in the Toolbox

® [Highlight Color] - uses the options selected
below:

- [Catalog] - select your printer’s catalog from
the drop-down list

- [Printer Palette] - select your printer’s color
palette from the drop-down list

- [Ink Dominance] - select the dominant color
(if colors overlap):

— [Default] - prints the dominant ink color,
depending on your printer’s default

— [Black] - prints black on color

— [Color] - prints in the currently selected
color in the

® [Full color] - uses color for borders, interior fills,
texts and graphics, if supported by your printer
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Page Offset

Enter offset values used when converting Elixir-format
forms (.ELX) to AFP overlay format (.OVE). This shift
does not display on screen.

e [Xoffset] - output shifts right by the units specified
in the Units of measure field

® [Yoffset] - output shifts down by the units speci-
fied in the Units of measure field

Exceeding form page size limits

When you change the size or orientation of an existing
form, some form elements may extend beyond the
page boundary.

If this happens, the Objects Off Page dialog box
displays.

I Objects Off Page I

2 Objects DIf Page:

2 Texts: [+ Delete | [ Ignore | [ Moveln |
xCanceI

Figure 4-5. Objects Off Page dialog box

The Objects Off Page dialog box lists (by type) all
form elements that extend beyond the page bounda-
ries. For each object, select an action, then click on
[OKT:

Delete
Deletes the object from the form.

Ignore
Increases the page size to accommodate the object.

Move in
Moves the object inside the page boundaries. Form
objects may now overlap.
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Clip
Eliminate only that portion of object that is off page.

Page databasing

The Page Databasing dialog box displays when select
[New Form] from the File menu. The entered informa-
tion stores with the form until it is changed or deleted,
but does not print with the form.

To edit databasing information:

1. Select [Page Databasing] from the Options
menu.

The Page Databasing dialog box displays.

Short Page Dezscnplion:

Fage Version: D Page Hevision: |:| LocaliD: _‘

Long Page Comments:

Stare DatelTime Stamp
Date Format [+ WM/DDAYY [ Vo/MM/DD || DOMHAY] o | |
Time Eormat |+ 12 Hous am/pm 3G D

Figure 4-6. Page Databasing dialog box
2. Select/enter information, then click on [OK].

The Page Databasing dialog box contains the follow-
ing options:

Short Page Description
Enter a short description (maximum 60 characters) for
the form.

Page Author
Enter the user ID (maximum 8 characters).
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Made for
Enter the name of the customer (maximum 13
characters).

Page Version
Enter the version number (maximum two characters).

Page Revision
Enter the form revision or modification identifier (one
character only).

Local ID

Enter a name for the form (maximum 8 characters).
This name is used as a comment in the [Made for]
option.

Long Page Comments

Enter comments for the form (maximum 240 charac-
ters). Use the mouse to move to another line or any
place within the comments box. Comments save with
each form until they are changed or deleted.

Store Date/Time Stamp
Assigns a date or time stamp to the form after output
datastream generation.

Date Format
Select the month/day/year/ format for the date pro-
vided by the [Store Date/Time Stamp] option.

sc:
Enter a date separator character (default /).

Time Format
Select a time format; [12 Hour am/pm] or [24 Hour].

sc:
Enter a time separator character (default ;).

4-12 ELIXIR TECHNOLOGIES CORPORATION



ELIXIRFORM DEFAULTS

Text and font options

To specify form text and font defaults:

1. Select [Text/Fonts Options] from the Options
menu.

The Text and Font Options dialog box displays.

Text Dlsplﬂy Optmns -

Text Tab Length apacea

Text Formatting Compatibility
5 and Grid Step Procision

+ Wmdawﬁ

Fr:mt Opnons  _ Text lmpmt Uptmns:,
. SortFontlist - ,' . Separate
: . paragraphs

Join Fext US'“Q . .
[ Spaces || Jusy | Relatves | RTF Paste Options
Keyboard !ﬁput Optigns. . “irosebom

¥ Filter control codes oninput ¥ Paste Colors

Figure 4-74. Text and Font Options dialog box
2. Select/enter information, then click on [OK].

The Text and Font Options dialog box contains the fol-
lowing options:

Text Display Options

Text Tab Length

Enter the text tab length. The initial default setting is 5.
Tab length is based on the width of the space charac-
ter in the active font.

The tab length setting applies to all tabs on the current
form (including those previously entered).
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Text Display Options

Text Formatting Compatibility and Grid Step Pre-
cision

Select the text formatting and grid precision for the
current form:

e [GEM] - uses original boxed text formatting of a
form created in ElixirForm prior to version 3.0; in-
ternal grid step precision set to 0.1 dots

®* [Windows] - uses Windows boxed text formatting;
internal grid step precision set to 0.01 dots

Text Display Options
Tag Display
Prints the data tags included in Elixir forms.

®* [None] - does not print the data tags

®* [Replace Char] - prints the data tag field length
and replacement characters

® [Tag Name] - prints the data tag's field name

See your Elixir DataMerge User Guide or Elixir Docu-
Tag User Guide for more information.

Font Options
Font Preference
Select the default font type: [Screen] or [Elixir].

Font Options
Sort Font List
Alphabetically sorts the font list.

Text Import Options

Lock position

Locks text imported from an ASCII file in its initial po-
sition in the Work area. Subsequent text blocks are
positioned directly underneath the first text block.

Text Import Options

Separate paragraphs

Allows you to place imported text blocks at different
locations on the form. Paragraphs separated by two
carriage returns create separate blocks you can place
separately. See the "Text operations" chapter for
more information on importing text.
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Join Text Using
Select the format to group blocks of text into a single
block:

® [Spaces] - each text block displays under the pre-
vious text block; original line beginnings and end-
ings are kept

e [Justify] - joined text displays as one continuous
paragraph; the width of the joined text is deter-
mined by the position of the left-most and right-
most characters in the text blocks

* [Relatives] - each text block retains its position
relative to the previous text block

To take out unwanted spaces or perform paragraph
formatting operations, deselect then select the [Text -
Word Wrapping] option in the Text toolbox. See the
"Text operations” chapter for information on how to
join text.

Keyboard Input Options

Filter control codes on input

Prevents inadvertent keyboard entry of control codes,
such as characters below decimal 32 (a space).

RTF Paste Options
Select RTF import options:

® [Paste Fonts] - maintains font(s) specified in the
imported text file

® [Paste Colors] - maintains color(s) specified in the
imported text file

GEM form defaults

For forms created using ElixirForm prior to version
3.0, use the GEM Forms Load Defaults dialog box to
select text formatting, grid step precision and color
mode settings. These settings then apply to all subse-
qguently loaded GEM forms.
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To change settings for the currently loaded GEM form
only, see the "Selecting page properties" and "Text
and font options" sections.

To select GEM form defaults:

1. Select [GEM Forms Load Defaults] from the
Options menu.

The GEM Forms Load Defaults dialog box dis-
plays.

GEM Forms Load Detaglts |

~Figure 4-8. GEM Forms Load Defaults dialog box

2. Select display options, then click on [OK].

The GEM Forms Load Defaults dialog box contains
the following options:

Options in this dialog box may or may not display, de-
pending on the options selected.

Extend Lines by Halfwidth

Displays horizontal and vertical lines with extensions
equal to half the line thickness at each end. Affects
the printed output only.

4-16

ELIXIR TECHNOLOGIES CORPORATION



ELIXIRFORM DEFAULTS

Text Formatting Compatibility and Grid Step Pre-
cision

Select the text formatting and grid precision for loaded
GEM forms:

® [GEM] - uses original boxed text formatting of a
form created in ElixirForm prior to version 3.0; in-
ternal grid step precision set to 0.1 dots

® [Windows] - (default) uses Windows boxed text
formatting; internal grid step precision set to 0.01
dots

Your selection is written to the Elixir SYSTEM.INI
file. This formatting affects all GEM forms loaded
afterwards.

Color Mode
Select the display color for loaded GEM forms:

®* [Black & White] - GEM form displays in black and
white

® [Highlight Color] - GEM form displays with the op-
tions selected below:

- [PAL palette] - select an internal PAL palette
from the drop-down list

- [Catalog] - select your printer’s catalog from
the drop-down list

- [Printer Palette] - select your printer’s color
palette from the drop-down list

® [Full Color] - GEM form displays with the full color
palette selected below:

Configuring the system

ElixirForm allows you to configure your system and to
save the configuration for subsequent work sessions.
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Setting usage defaults

To select ElixirForm usage settings:

1. Select [Usage Switches] from the System
menu.

The Usage Switches dialog box displays.

I Usage Switches I

vl é /| Show Quick Help
_ | Extend Lines by Halfwidth | Show Form Dimensions
Show Lines as WYSIWYG: [~ 240DFI[[+ 300DFI|[ = OFF]

V Ok xl:ancel ? Help

Figure 4-9. Usage Switches dialog box

2. Select display options, then click on [OK].

The Usage Switches dialog box contains the following
options:

Save State on Exit
Saves the current menu and option settings when you
exit ElixirForm.

Extend Lines by Halfwidth

Displays horizontal and vertical lines with extensions
equal to half the line thickness at each end. Affects
the screen display only - lines print as drawn.

Show Quick Help
Displays a short description of any icon that your cur-
sor passes over in the Message area.

Show Form Dimensions
Display the dimensions of the current form in the up-
per right hand corner of the screen.

Show Lines as WYSIWYG
Select a display resolution:

® [240DPI] - lines and shape borders display as
WYSIWYG on high-resolution monitors.
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® [300DPI] - displays lines at 300 dpi and shape
borders at 240 dpi

® [OFF] - for low resolution monitors such as VGA.
Light and medium lines and borders may display
as the same thickness on low resolution monitors
if this option is not selected.

Filing options

ElixirForm allows you to specify default directories for

forms, screen fonts, Elixir images, screen images,

texts, tags and Elixir-format documents. Entered in-

formation saves to your SYSTEM.INI file.

To specify default filing information:

1. Select [Filing Options] from the System menu.
The Filing Options dialog box displays.

B Filing Options

Hake Backupfite {wi& mm}

Z Loadiast Form -

o Dt mm Biowss §::§

: smgw Diieciow 11: \ELIXIR\FONTS\SCREENADEMON { i :

: gmwam 11: AELIXIRAPICS\PRINTERS E Hiomee i =
Scicenlmages Diectony:  [CAELIIRAPICS\SCREENY | Biowse |
Touts Dhoctons jc VELIXIRATEXTSA } Browse }
S| —

. £l Documents Dirsctory [CAELIXIRADOCSA\DOCLIST |

Figure 4-10. Filing Options dialog box

2. Select/enter filing information, then click on
[OK].
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The Filing Options dialog box contains the folowing
options:

Autosave

Enter a time interval from 1 to 9 minutes in the Save
interval field to automatically save your currently active
form. The back-up form saves as AUTOBACK.ELX in
the default forms directory.

Make Backup File (with .BAK extension)

Creates a back-up copy (.BAK) of the form which is
overwritten only when you select [Save] from the File
menu. The [Autosave] option does not overwrite this
file.

The back-up file writes to the default forms directory
and has the same stem name as the original file with
a .BAK extension.

Load Last Form
Automatically loads the form you last worked on when
you start a new ElixirForm session.

Write PostScript File on Form Save
Creates a PostScript file in the directory specified in
the [Doc. Directory] option when the Form saves.

Forms Directory

Enter the directory for Elixir-format form files (.ELX) or
click on the [Browse] button and select one from the
Select Forms directory dialog box. Default is
drive:\ELIXIR\FORMS\ELIXIR\DEMO.

Screen Fonts Directory

Enter the directory for Elixir-format screen font files
(.FNT) and width tables (WDT) or click on the
[Browse] button and select one from the Select
Screen Fonts directory dialog box. Default is
drive:\ELIXIR\FONTS\SCREEN\DEMO. See the "Text
operations" chapter for more information on screen
and other fonts.

Elixir Images Directory

Enter the directory for Elixir-format image files (.LP3)
or click on the [Browse] button and select one from
the Select Elixir Images directory dialog box. Default is
drive:\ELIXIR\PICS\PRINTER. See the "Images"
chapter for more information on images.
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Screen Images Directory

Enter the directory for Elixir-format screen image files
(.LW8) or click on the [Browse] button and select one
from the Select Screen Images directory dialog box.
Default is drive:\ELIXIR\PICS\SCREEN. See the "Im-
ages" chapter for more information on screen images.

Texts Directory

Enter the directory for imported ASCII text files (.TXT)
or click on the [Browse] button and select one from
the Select Texts directory dialog box. Default is
drive:\ELIXIR\TEXTS.

Tags Directory

Enter the directory for tag files ((.TAG) or click on the
[Browse] button and select one from the Select Tags
directory dialog box. Tag files are used with DocuTag
for external tag files called for in a form. Default is
drive:\ELIXIR. See your Elixir DocuTag for AFP User
Guide for more information.

Elixir Documents Directory

Enter the directory for the Elixir-format documents
(.DAT) or click on the [Browse] button and select one
from the Select Elixir Documents directory dialog box.
Default is drive:\ELIXIR\DOCS\DOCLIST.

Resetting to defaults

To reset Toolbox options to default values:

1. Select [Reset to Defaults] from the System
menu.

2. Click on [OK].

Saving a configuration

To save the configuration settings specified above,
select [Save Configuration] from the System menu.

The configuration saves for the next time you open
ElixirForm. If the font and screen directories change
in the Elixir Desktop, these changes apply next time
ElixirForm loads.
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This chapter describes how to draw and edit lines,
with references made to options in the Line tool in the
Toolbox.

Line display

The following section provides information about line
display.

Setting the screen display

Screen refresh

If you are using a low resolution monitor such as VGA,
you should set the [Show Lines as WYSIWYG] option
in the Usage Switches dialog box to [Off]; if you do
not, thin lines and borders may display the same
thickness as medium lines and borders.

See the "ElixirForm defaults" chapter for more in-
formation.

After a screen refresh, overlapping lines and boxes
may not display or print in the "front to back" order in
which they were drawn. For example, a shaded box
drawn on top of an existing line may display with the
line on top of the box after a screen refresh operation.
This is due to the page resorting method (from top left
to bottom right) required by certain printers.

To prevent elements refreshing to an incorrect "front
to back" order, avoid drawing elements that overlap.
For example, to draw a box with lines extending from
its borders, connect individual lines to the border of
the box instead of drawing the box on top of a line that
extends beneath and beyond its borders.
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Drawing lines

ElixirForm allows you to draw vertical, horizontal and
free lines. You can also specify line thickness, style
and color by selecting options from the Line toolbox.

To display the Line toolbox, select the Toolbox Line
tool or select [Line] from the Tools menu.

Figure 5-1. Line toolbox

To start and end a line at grid points, click on the Tool-
bar [Show Grid] and [Snap to Grid] options.

If you want the line to snap to grid mid-points as well
as to grid points, set the [Grid Snap] option in the Grid
Setting dialog box to [Half Grid]. See the "ElixirForm
basics" chapter for more information.

To draw a line:

1. Position the screen pointer in the Work area
where you want the line to begin, then press
and hold the mouse.

2. Drag the screen pointer across the Work area.
A line displays.

3. To end the line, release the mouse.

The line locks into position.
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4. Select line properties in the Line toolbox.
The Line toolbox contains the following options:

Line Direction
Select a direction for the line: [Horizontal only], [Verti-
cal only], [Horizontal and Vertical] or [Free].

Line Width

Select a width for the line: [Thin] 2 dot, [Medium] 4 dot
or [Thick] 6 dot line widths. You can also click on the
up or down scroll arrow to increment line width by one
dot, or click on the current width display and enter a
new line width value up to 99 dots.

Line Style
Select a line style: [Solid], [Dashed] or [Dotted].

Line Color

If your printer supports color, select a color for the line
as follows:

1. Select the [Color] option.

If you cannot see the color option, select the Page
Properties dialog box [Full Color] option.

The Color dialog box displays.

2. Select a color, then click on the [Color]
button.

3. Place the cursor in the Work area and draw a
line.

The line displays in the color you selected.
All subsequently drawn lines display the same color

until you select another color. Line color selections are
saved with the form when you select [Save].

Editing lines

Ik

To select a line for editing:

1. Select the Toolbox Select/Edit tool.
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Place the cursor on the line you want to edit.
then right-click.

Boxes appear at each end of the selected line.
The Line toolbox displays.

You can now change the line length and attributes.

Changing line length

You can change the length of a line by either entering
new position coordinates or modifying it directly on the
form.

To change line coordinates:

LT 1.28
x 1.62 1. Select the Toolbar Current Object - Start
Coordinates area.
If you cannot click on this area, select the line
again, then right-click.

2. Backspace over current value(s) or press the
<Del> key to delete the value(s), enter new
coordinate value(s), then press <Enter>.

If allowed, you can use the <-> key to enter a
negative value.
The line adjusts to the new coordinates.

To manually change line length:

1. Place the cursor at the end of the selected
line.

The cursor changes to a four-way arrow.

2. Drag the end of the line until it reaches the
desired length.

3. Release the mouse button.

The changed line locks into position.
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Sticky Lines <Ctrl> + <L>

When you select the [Sticky Lines] option in the
Select/Edit toolbox, perpendicular connected lines
stick together when you either move one of the lines
or change line size. Lines connected to form the sides
of boxes also remain attached when you either move
or resize the box. If you deselect the [Sticky Lines] op-
tion, only the selected line is affected by subsequent
line moves or size changes.

‘:Iﬂ You must select either the [Horizontal only] or [Vertical
only] option in the Toolbox when moving sticky lines.
This requirement does not apply when moving or
resizing boxes.
To create sticky lines:

1. Select the [Sticky Lines] option, then select a
line and press <Ctrl>+<L>.

2. Select a line movement restriction option:
[Horizontal only] or [Vertical only].

3. Resize a box either horizontally by moving its
left or right side or vertically by moving its top
or bottom side.

4. Release the mouse button.

The sticky line or box locks into position.

Changing line attributes

To change line width, style or color:

1. Select a line.
To change the attributes of multiple lines, shift-
click on each line or use the group feature de-
scribed in the "Elixir Form basics" chapter.

2. Select the desired option(s) from the Line
toolbox.

The properties apply to the line(s) you selected.
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Copying lines

To copy a line:

1. Select the Toolbox Select/Edit tool.

2. Select the Toolbox [Copy] option.

ﬂiﬂ 3. Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

4. Select the line you want to copy.

Boxes appear on the line when selected.

-
4k

|IE'$LI:I 5. Select the desired number of copies (99 maxi-
mum) by either clicking on the up or down
arrows or clicking on the numeric display box
and entering a new number.

Holding down the <Ctrl> key while clicking on the
arrows increases or decreases the value dis-
played by 10.

6. Select the line and drag it to where you want
the duplicate line(s) placed.

7. Release the mouse button.

The duplicate line(s) lock into position.

Moving lines

To manually move a line:

Ri 1. Select the Toolbox Select/Edit tool.

ﬂiﬂ 2. Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

3. Select the line to move.

Boxes appear on the line when selected and the
screen pointer changes to a hand.
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If the screen pointer does not change to a hand,
press and hold the <Ctrl> key as you move the
cursor over the line. When the screen pointer
turns into a hand, you can move the line.

4. Click and drag the line to the new position.
5. Release the mouse button.

The line locks in the new position.
To move a line by entering new coordinates:

»l
x 162 1. Select the Toolbar Current Object - Start
Coordinates area.

If you cannot click on this area, select the line
again, then right-click.

2. Backspace over the current values or press
the <Del> key to delete the current values,
enter new coordinate values, then press
<Enter>.

The line adjusts to the new coordinates.

If the sticky lines option is selected, connecting
lines and lines attached to the sides of boxes re-
main attached when one of the lines or the box is
moved. See the "Sticky Lines" section for more
information.

Deleting lines

To delete a line:

L} 1. Select the Toolbox Select/Edit tool.

2. Select the line to delete, then press <Del>.

To restore a line immediately after deletion, either se-
lect the Toolbar Undo icon or select [Undo] from the
Edit menu.
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This chapter describes how to draw and edit shapes
using ElixirForm.

Drawing shapes

o

]

O

Drawing paths

ElixirForm allows you to draw paths, boxes and cir-
cles, and to apply attributes to these shapes by select-
ing options from the Toolbox.

If you want a box or path to start and end at grid
points, select the Toolbar [Grid] and [Snap to Grid]
icons.

If you want a box or path to snap to grid mid-points as
well as to grid points, set the Grid Setting dialog box
[Grid Snap to] option to [Half Grid].

To draw a shape, click a Toolbox shape tool and se-
lect the options for the shape.

ElixirForm allows you to draw free paths or paths that
shap to horizontal and vertical lines. You can specify
path properties by selecting Path toolbox options.

To display the Path toolbox, either select the Path tool
or pull down the Tools menu and select [Path]. The
Path toolbox displays.
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Figure 6-1. Path toolbox

You draw a path in segments. To draw a path:

1.
2,

Move the screen pointer into the work area.

Click and drag the screen pointer to draw the
first path segment.

Release the mouse button to finish the seg-
ment.

Draw the next and subsequent segments by
repeating the above procedure.

The next segment begins where the last ended.

End the path by double-clicking or selecting
the Finish Drawing option.

Select path properties from the Path toolbox.
When path completed, toggle the Path - Finish

Drawing option to [Done] or double-click in
the work area.

The Path toolbox contains the following options:

Path - Shape

Select open or closed paths. An open path remains
open and a closed path automatically closes when
you finish drawin the path.

6-2

ELIXIR TECHNOLOGIES CORPORATION



SHAPES

Drawing boxes

Path - Direction

Specify either [Snapped] or [Free] line segments.
[Snapped] draws lines that snap to horizontal and ver-
tical grid lines; [Free] draws line segments in any di-
rection.

Path - Beginning and End Styles
Select a line beginning and end style: Square, round
or mitered ends.

Custom Line/Border Thickness
Select standard [2], [4] or [6] border widths. Click on
the up or down arrow to change the border width by
one dot, or click on the current value and enter a new
border width value up to 99 dots.

Line/Border Style
Select [Dotted], [Dashed] or [Solid].

Path - Finish Drawing
When you click in the Work area to add a path, you
are in [Draw] mode. When you complete a path, se-
lect this option a second time or right-click in the Work
area to toggle to [Done].

Object Fill Pattern/Shading

Applies shaded patterns to closed paths. To select a
shade, click on a shade pattern in the Pattern dialog
box. The pattern applies each time you draw a new
closed path, until you change the pattern. Select the
white shade box for no shading.

Path - Connection Radius

Select the value of the path connection radius by click-
ing on the radius window up or down arrows, or click
in the numeric display box and enter a value (maxi-
mum 299 pels).

You can also select: [Small] 10 pels, [Medium] 20
pels, [Large] 30 pels, [Square], [Radius Half], or [Ra-
dius Maximum].

ElixirForm allows you to create split boxes (for exam-
ple, one box evenly divided or split into two or more
boxes), shaded boxes and boxes with varying borders
and styles.
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To draw a box:

1.

Select the Box tool in the Toolbox.

The Box toolbox displays.

Figure 6-2 Box toolbox

Position the screen pointer in the work area
where you want a box corner.

Press and hold the mouse button.

Drag the screen pointer to form the shape of a
box.

Release the mouse button to finish the box.
You can use the arrow keys to pan around the
screen when drawing a box that exceeds work
area boundaries.

Select box properties from the Box toolbox.

Select one of the following options to cor-
respond to above width and style selections:

Border Lines
Select to set the width and style of box borders
(and diagonals, if selected).
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Horizontal Lines
Select to set the width and style of horizontal
splits in a box (see Box Splits, below).

Vertical Lines
Select to set the width and style of vertical splits
in a box (see Box Splits, below).

8. When shape completed, toggle the Path -
Finish Drawing option to [Done] or
double-click in the Work area.

The Box toolbox contains the following options:

g@ Box - Predefined Shape
Select the box corner style: [All corners square], [All
EEEE corners rounded], [Top rounded/bottom square], [Top

square/bottom rounded], [Left rounded/right square],
or [Left square/right rounded].

Box - Positioning Center/Top Left

Select the top half of this option to center the top left
corner of the box on grid coordinates. Select the bot-
tom half of the option to snap the top left corner of the
box flush to grid coordinates.

Box - Shape Oblong/Square

Select the top half of this icon to draw boxes as rec-
tangles. Select the bottom half of this icon to draw
boxes as squares.

Box - Diagonals
El 2| Select the diagonal line pattern for inside the box:

[None], [Left] ,[Right], or [Both]. Each option displays
a sample box.
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Custom Line/Border Thickness

Specify a value (in dots) by clicking on the up or down
arrows, or click in the numeric display box and enter a
value (maximum 99 dots). Specify [0] to apply an in-
visible border to a shaded box. Unshaded boxes
must have a border width of [1] or higher.

You can also select: [Thin], [Medium], or [Thick] box
line widths.

Box - Line Style
To set the box line style, select the [Solid], [Dashed] or
[Dotted] option.

Box - Line Thickness and Style
Select width and style options:

® [Border Lines] - sets the width and style of the box
border

® [Horizontal Lines] - sets the width and style of the
horizontal box splits

® [Vertical Lines] - sets the width and style of the
vertical box splits

Select the [Horizontal Lines] and [Vertical Lines] op-
tions to apply box splits using the Box Splits -
Horizontal/Vertical option.

Box - Horizontal Spilit
Select the number of equal horizontal portions to di-
vide the box into by clicking on the up or down arrows.

You can also select the Box Splits option and enter
the number of portions in the numeric display box next
to each option. The minimum value is 1 (hollow) and
the maximum value is 40.

Box - Horizontal Split - ON/OFF
Enables the Box - Horizontal Split option. Select this
option a second time to disable this feature.

Box - Vertical Split
Select the number of equal vertical portions to divide
the box into by clicking on the up or down arrows.

You can also select the Box Splits option and enter
the number of portions in the numeric display box next
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to each option. The minimum value is 1 (hollow) and
the maximum value is 40.

Box - Vertical Split - ON/OFF
Enables the Box - Vertical Split option. Select this op-
tion a second time to disable this feature.

Box - Color

Select a box border color from the palette in the Color
dialog box, then click on the [Close] button. The se-
lected box color displays in the bottom half of the icon.

Box - Fill Color

Right-click to select a box fill color from the palette in
the Color dialog box, then click on the [Close] button.
The selected box fill color displays in the bottom half
of the icon.

Object Fill Pattern/Shading

Select the [Box Shading] option to apply shaded pat-
terns to boxes. The Pattern dialog box displays the
available shade patterns. To select a shade, click on a
shade pattern. All the boxes you draw contain this
shading until you change it using the same procedure.
Select the white shade box for no shading.

10 FIT r|r'|r'| Box - Corner Radius _
Select an option for the radius of the corners. Cus-

tomize the radius by clicking on the up or down arrow
to increase or decrease the corner radius by one pel.
The maximum value is 299 pels.

The [Corner Radius] option does not apply when all
corner styles are 90 degrees.

Drawing circles

ElixirForm allows you to draw circles or circle seg-
ments as follows:

O 1. Select the Circle tool in the Toolbox.
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The Circle toolbox displays.

Figure 6-3. Circle toolbox

Click in the Work area and drag the screen
pointer to form a circle.

Release the mouse button to finish the circle.

Select circle properties from the Circle
toolbox.

When circle completed, toggle the Path -
Finish Drawing option to [Done] or
double-click in the Work area.

Circle - Radius

Select one or more of the four circle quarters to
compose a circle or partial circle. Select a quarter
a second time to deselect it.

Circle - Drawing Method

Select the top half of this option to draw a circle
from its center outward, where the anchor point is
the circle center.

Select the bottom half of this option to draw a cir-
cle within an unseen box, where the anchor point
is the box corner nearest the starting point. This
method allows you be more precisely place the
circle in relation to another element.
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Circle - Diagonals
Select the diagonal line pattern for inside the cir-
cle: [None], [Left], [Right], or [Both].

Only 360-degree circles display diagonals.

Custom Line/Border Thickness

Specify a value (in dots) by clicking on the up or
down arrows or click in the numeric display box
and enter a value (maximum 99 dots). Specify [0]
to apply an invisible border to a shaded circle.
Unshaded circles must have a border width of [1]
or higher.

You can also select: [Thin], [Medium], or [Thick]
border widths.

Circle - Border Style
Select the circle line style: [Solid], [Dashed], or
[Dotted].

Circle - Start and Finish Angle

Specify a value by clicking on the up or down ar-
rows or click in the numeric display box and enter
a value (in degrees) for where you want your cir-
cle to begin and end.

You can also select: [0], [90], [180], or [270]
degrees.

Circle - Color
Select a circle border color from the palette in the
Color dialog box, then click on the [Close] button.
The selected circle color displays in the bottom
half of the icon.

Circle - Fill Color

Right-click to select a circle fill color from the pal-
ette in the Color dialog box, then click on the
[Close] button. The selected circle fill color dis-
plays in the bottom half of the icon.

Object Fill Pattern/Shading

Select a shade pattern from the Pattern dialog
box. All circles you draw contain this shading until
you change it, using the same procedure. Select
[Hollow] for no shading.
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Circle Axis
Select an axis on which circles print to an AFP
printer:
+ [None] - no axis
[Horizontal] - horizontal axis

[Vertical] - vertical axis

+  [Both] - horizontal and vertical axis

Editing shapes

To change the properties of a shape, you must first
select it.

To select a shape:

1.
2,

Select the Select/Edit tool in the Toolbox.
Right-click on the shape you want to edit.
The Toolbox displays the shape's options.

Boxes display around or inside the shape to show
it is selected.

Changing shape size

You can change the size of a selected shape by enter-
ing new dimension coordinates or manually modifying
the shape directly on the form.

Changing dimension coordinates

To change shape dimension coordinates:

" 1.28
2 162 1. Select the Toolbox Current Object - Start
Coordinates area.
If you cannot click on this area, select the shape
again, then right-click.
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Backspace over the current values or press
the <Del> key to delete the current values,
enter new coordinate values, then press
<Enter>.

The shape adjusts to the new coordinates.

Manually

To change a shape manually:

1.

ki

3.

Place the cursor on one of the boxes around
the shape.

The cursor changes to a double-ended arrow.

Drag the cursor until the shape reaches the
new size.

Release the mouse button.

Changing shape attributes

To change an attribute of a shape:

1.
2,

Select a shape.
Select an option from the shape's toolbox.

If the shape's toolbox does not display, reselect
the shape, then right-click.

To change the attributes of multiple shapes,
shift-click on each shape.

The selected properties apply to all the selected
shapes, if available.

See the "ElixirForm basics" chapter for more in-
formation on grouping elements.
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Copying shapes

To copy a shape:

1.
2,

ol

-
OG
(3]

Select the Select/Edit tool in the Toolbox.
Select the [Copy] option.

Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

Select the shape to copy.
Boxes display on the shape to show it is selected.

Click on the up or down arrows to select the
number of copies between 1 and 99.

Hold down the <Ctrl> key while clicking on the ar-
rows to increase or decrease the value by 10.
You can also backspace over the value and enter
a new value from the keyboard.

Click and drag the selected shape to the
desired position, then release the mouse
button.

The duplicate shapes lock into position.

Moving shapes

You can move a shape about the Work area manually
or by changing its dimension coordinates.

Manually

To move a shape manually:

ot

Select the Toolbox Select/Edit tool.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

Select the shape to move.
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Boxes display around the shape to show it is
selected.

Click and drag the selected shape to a new
position, then release the mouse button.

The screen pointer changes to a hand when you
select the shape. If it does not, the shape may be
too small. If this happens, press and hold <Ctrl>
you move the cursor over the shape.

The shape locks in the new position.

Changing dimension coordinates

To move a shape using dimension coordinates:

Select the Toolbar Current Object - Start
Coordinates area.

If you cannot click on this area, select the shape
again, then right-click.

Backspace over the current values or press
the <Del> key to delete the current values,
enter new coordinate values, then press
<Enter>.

The shape moves to the new coordinates.

Deleting shapes <Del>

R

To delete a shape:

1.
2,

Select the Select/Edit tool from the Toolbox.
Select the shape to delete.

Boxes display around the selected shape.
Press <Del>.

The shape deletes.
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To restore a deleted shape, immediately click on
the Toolbar Undo icon or select [Undo] from the
Edit menu.
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7. Text operations

This chapter describes ElixirForm text operations.

Creating text

You can create form text using either Elixir screen,
TrueType or ATM fonts. You can insert text either by
entering text directly from the keyboard or by import-
ing text from an ASCII file.

Apply text properties by selecting options from the
Text toolbox.

A To display the Text toolbox, select the Text tool or pull
down the Tools menu and select [Text].

Figure 7-1. Text toolbox
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Entering text from the keyboard

To enter text directly from the keyboard:

1.

Select the text attributes from the Text
toolbox.

Select the [Text - Load Font List] option.
The Load Font List dialog box displays.
Select a font list, then click on [OK].

The selected font(s) list displays in the Font Pre-
view Panel.

Select a font list, then click in the Work area
where you want the text to appear.

Enter characters from the keyboard, then
right-click when done.

Entered text displays in the Work area.

Moving a block before finish entering text

To move a text block before you finish entering text:

1.
2,
3.

4,

Press and hold down the <Ctrl> key.
Place the cursor on the text block.

Click and drag the text block to a new
location.

Release the mouse button to place the text.

To move a text block after you finish entering text, see
the "Moving text" section in this chapter.
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Specifying text attributes

L=

ab o

i

Select Text toolbox options to specify text attributes.
The Text toolbox contains the following options:

Text Direction
Select a text display direction:

® [Across] - left to right
e [Down] - top to bottom
® [Back] - right to left

® [Up] - bottom to top

Text - Inter-character/Inter-word Spacing
Select a display spacing option:

® [Inter-character] - justifies all text blocks by in-
creasing or decreasing the amount of space be-
tween characters. This makes the form easier to
read when converted to OGL, but takes longer for
the form to print.

® [Inter-word] - justifies all text blocks by increasing
or decreasing the amount of space between
words.

These options are global features. Selected options
apply to all text blocks on the form.

Text - Word Wrapping

Wraps text between the boundaries set in the [Col-
umn Width] option. You can also select the [Box Text]
option and draw a visual box on your form to contain
the text. Select this option when text is justified.

Text - Remove Redundant Spaces

Removes redundant spaces, relative shifts and car-
riage returns from text blocks that have the Text -
Word Wrapping option selected.

Text - Split String
Splits a single block of text into two separate text
blocks.
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== gpecify the justification for each text block: [Left Justi-
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Text - Justification

fication], [Center Justification], [Right Justification], or
[Full Justification].

The [Wrap Text] and [Box Text] or [Column Width] op-
tions must be selected for text justification.

Text - Positioning

When the [Wrap text] option is selected, you can
specify the vertical positioning of a text block: [Top],
[Center] or [Bottom].

Use this option with [Text Justification] and [Box Text]
to place text in nine positions within the box.

Text - Lines per Inch

Specify a vertical lines per inch (LPI) value by clicking
on the up or down arrows or click in the numeric dis-
play box and enter a number. Press and hold <Ctrl>
while clicking to increase/decrease the value by 1.0.
This value you affects the current block of text and
any subsequent blocks of text entered using the same
font.

To return the lines per inch to the default for the cur-
rent font, use the down arrow to decrease the LPI
value to [0] or press <Del>.

Text - Lines per Inch - ON/OFF
Enables the Text - Lines per Inch option. Select this
option a second time to disable this feature.

Text - Color

If supported by your printer, you can apply color to a
text block. Color selection applies to the whole text
block, rather than a single word.

Select a text color from the palette in the Color dialog
box, then click on the [Close] button. The selected
color displays in the bottom half of the icon.
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To apply color to a text block:
1. Select the [Color] option.
The Color dialog box displays.
2. Select a color, then click on [OK].

3. Position the cursor in the work area, then
enter text.

The selected color applies to entered text, and
continues for all subsequent text blocks until you
select another color.

DocuTag/DataMerge - Data Tags - ON/OFF
Displays the Data Tagging dialog box which allows
you to add data tags to forms for use with Elixir's
DocuTag or DataMerge products. Select this option a
second time to disable this feature.

See your Elixir DocuTag User Guide or Elixir Da-
taMerge User Guide for more information on creating
data tags and tag lists.

Column Width and Height

Specify the width and height for a text block by click-
ing on the up or down arrows or click in the numeric
display boxes and enter a number. Press and hold
<Ctrl> while clicking to increase/decrease the value by
1.0. Values that exceed the form limits are not
accepted.

You must select the [Wrap] text option when using
these options. When these options are set to [0.00],
text entered is bound only by the width and height of
the form.

Select the [Box Text] option along with these options
to display a visual guide box with the width and height
dimensions you specify.
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Text - Draw Column Box Boundaries

Select this option after selecting the [Box Text] option
to define column boundaries for text by drawing a vis-
ual box in the Work area. Place the cursor in the
Work area and press and hold down the mouse but-
ton. Drag the box that displays and release the
mouse button at the bottom right of the box. This box
does not print.

Select the [Wrap Text] option to wrap text at the
boundary of the text box defined by this option. Select
the [Text Positioning] option to position text within the
text box.

Text - Set Column Width/Height to Define Box -
ON/OFF

Select this option when using the [Draw Text Box] or
[Column Width] and [Column Height] options to enter
text in predefined areas or "boxes." Select this option
a second time to enter free text which is bound only by
the width and height of the form.

Box boundaries are defined by entering values in the
[Column Width] and [Column Height] options or by
drawing a box manually using the [Draw Text Box]
option.

Boxed Text/Free Text (toggle)

ElixirForm allows you to enter text in predefined areas

or "boxes." You can define the box boundaries by en-

tering dimension values for the column height and
width or by drawing a box manually.

To enter dimension values:

1. Select the [Box Text] option.

2. Enter values for the [Column Width] and
[Column Height] options, then click in the
work area.

A text box with the specified boundaries displays.

To draw a text box manually:

1. Select the [Box Text] option.

=

2. Select the [Draw Text Box] option.
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3. Place the cursor in the Work area and hold
down the mouse button.

4. Drag the box and release the button at the
bottom right of the box.

This box is not the same as one you draw using
the Box tool; rather, it is a visual aid for defining
the column width and height for a text block only.

5. Select the [Wrap text] option, then select text
positioning to [Top], [Center] or [Bottom].

6. Enter text in the box; press <Enter> to insert
carriage returns and begin new paragraphs.

7. When finished entering text, right-click.

Font Type
Click on this button until the desired font type displays:

® [f] - Elixir-version fonts
® [T]- True Type fonts
® [a]- ATM fonts

Text - Add/Remove Font from List
Select a font action. The dialog box that displays de-
pends on your selection in the [Font Type] option.

® [+] - displays the Add Fonts, Select True Type
fonts, or Select ATM fonts dialog box; select a
font(s) to add to the current Font List, then click
on the [ADD] button

You can select the Elixir-version of the font to add
(either .HDR or .FNT) from the drop-down list in
the Add Fonts dialog box.

® [-] - displays the Replace Font, Select True Type
Fonts, or Select ATM Fonts dialog box; select a
font(s) to remove from the current Font List, then
click on the [DEL] button. If the font is in use on
the form, select a replacement font from the Re-
place Font dialog box.

Text - Load Font List/Merge Font List/Save Font
List
Select a Font List action:

[#[2]#]
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[] =@aB5sEc
aAbBEcCAD=EFFy
@ xBaBF5ac
afAbkBcCdDe

Font list

e [down arrow] - displays the Load Font List dialog
box

® [double arrows] - displays the Merge Font List dia-
log box; add fonts to the current font list by load-
ing another font list

® [up arrow] - displays the Save Font List dialog
box; enter a new file name for the current font list,
or rename an existing font list

Text - Soft Keyboard

Enters characters that are not available on a standard
keyboard. See the "Text operations" chapter for more
information on using the soft keyboard.

Font Preview Panel

Displays the fonts available in the current Font List.
Click on the up or down arrow or use the scroll bar to
scroll through the list to change the current font.

Fonts in use on a form are denoted by a diamond
character to the left of the font name.

[&] =@aBsssc
AaABECCAdOtEIFY
E #BaB75ac
aAbBcldDe

[a] =@a1557c
aAsAcCd0asfrgn

ElixirForm allows you to select a font either from the
current list or one loaded from a new list. You can also
merge and save font lists.

ElixirForm has a limit of 16 fonts per form.

Selecting a font from the current list

When you open a new form, the current font list dis-
plays in the Font Preview Panel, with the current font
selected.

The font list displays Elixir-format screen font files
(.FNT) in the screen fonts directory defined in the Fil-
ing Options dialog box. During installation, the default
screen fonts directory is set to drive\ELIXIRIFONTS\
SCREEN\DEMO.

You can generate additional fonts for use in ElixirForm
using contour fonts. See the Elixir Desktop for AFP
User Guide for more information.
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The [Text - Load/Merge/Save Font List] option allows
you to select a new font list or merge lists and save it
with a new name.

Loading

To load a different font list:

1. Select [down arrow] in the [Text -
Load/Merge/Save Font List] option.

The Load Font List dialog box displays.
2. Select a font list file (.LST), then click on [OK].
The font list displays in the Font Preview Panel.

3. Select a font, then click on [OK].

Merging

You can merge the current font list with other font
lists, or add individual fonts from other lists.

To merge a font list with the current font list:

1. Select [down arrow] in the [Text -
Load/Merge/Save Font List] option.

The Merge Font List dialog box displays.

2. Select the font list to merge, then click on
[OK].

The fonts add to the current font list.

Customizing

You can create and save your own custom font lists.
To save a custom font list:

1. Select [up arrow] in the [Text -
Load/Merge/Save Font List] option.

The Save Font List dialog box displays.
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1|+

2,

Enter a new or existing file name, then click
on [OK].

Adding fonts

To add fonts to the current font list:

1.

Click on the [Font Type] option until the
desired font type (a=ATM, T=TrueType or
f=Elixir) displays.

Select the [Add Font] ([+]) option.

Depending on [Font Type] selected, either the Se-
lect ATM Fonts, Select TrueType Fonts or Add
Fonts dialog box displays.

Select the font to add, then click on [OK].

Repeat these steps for each font type and font
you want to add.

Removing fonts

To remove a font from the current list:

1.

Select the font name in the Font Preview
Panel.

Click on [-].

The font removes from the list. You cannot re-
move a font that is in use on your form.

Press <Ctrl> + <-> to delete all unused fonts from
the list.

Entering non-standard characters

The soft keyboard allows you to enter characters that

are not available on a standard keyboard.

1.

To type an extended character:

Place the cursor in the Work area where you
want the character to appear.

2. Select the [Soft Keyboard] option.
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The soft keyboard displays.

Figure 7-2. Soft Keyboard

3. Select character(s) from the soft keyboard.
The character(s) displays at the selected position.

4. Select the [Soft Keyboard] option a second
time, when finished.

You can also access the non-standard keyboard char-
acters by pressing <Alt> and entering the correspond-
ing decimal value using the numeric keypad.

The soft keyboard displays characters in the current
font size, so smaller fonts may be difficult to read. You
can change the current font to a larger point size, edit
using the soft keyboard, then change the text block
back to the smaller font after editing.

Importing text

ElixirForm allows you to import ASCII text as a com-
plete file or as separate text blocks (separated by two
carriage returns) from the directory specified in the Fil-
ing Options dialog box. Default is
drive:\ELIXIR\TEXTS.

You can change the attributes of an imported text
block by selecting the attributes from the Text tool be-
fore importing each block.

Before you import text, you must:

® Copy the ASCII file to the texts directory specified
in the Filing Options dialog box

® Assign the ASCII file a .TXT extension

®  Separate paragraphs (or text blocks) with two car-
riage returns
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Importing complete text blocks

1.

Select the Text tool in the Toolbox.
The Text toolbox displays.
Select one of the following options:

[Locked text] - the text block loads directly be-
low the previous block

[Free text] - the text block loads wherever you
click the screen pointer.

The Message area displays the current setting.

Select text attributes option(s) in the Text
toolbox.

Select [Text/Font Options] from the Options
menu.

The Text and Font Options dialog box displays.

Deselect [Import Text Options - Separate
paragraphs], then click on [OK].

Select [Import Text] from the File menu

The Import Text dialog displays the files in the
drive:\ELIXIR\TEXTS directory.

Select the file you want to load, then click on
[OK].

Press and hold the screen pointer to display
the first text block.

To scroll through the text blocks, continue
holding down the mouse button.

To scroll to the previous text block, press
<F3>.

To scroll to the next text block, press <F4>.
Drag the text and release the left mouse

button to place the first text block on the
form.
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10. Click to display and place the next text block.

11. Click on [OK] when done.

When an ASCII file is imported, the complete file
attaches to the cursor for positioning unless the
[Import Text Options - Lock position] option is se-
lected. In that case, the text file attaches to the
previous cursor position in the Work area.

The selected font size and the amount of loaded
text determines whether or not the whole ASCII
file can fit on a form.

Importing text as separate blocks

To import text as separate blocks:

1.

Select the Text tool in the Toolbox.
The Text toolbox displays.
Select one of the following options:

- [Locked text] - the text block loads directly be-
low the previous block

- [Free text] - the text block loads wherever you
click the screen pointer.

The Message area displays the current setting.

Select text attributes option(s) in the Text
toolbox.

Select [Import Text] from the File menu

The Import Text dialog displays the files in the
drive:\ELIXIR\TEXTS directory.

Select the file you want to load, then click on
[OK].

Press and hold the screen pointer to display
the first text block.

- To scroll through the text blocks, continue
holding down the mouse button.
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«  To scroll to the previous text block, press
<F3>.

To scroll to the next text block, press <F4>.
7. Drag the text and release the left mouse
button to place the first text block on the
form.

8. Click to display and place the next text block.

9. Click on [OK] when done.

Importing text into a box

When importing text into a text box, you must define
the text box size first. See the "Specifying text attrib-
utes" section for information about boxed text.

Text imported into a box does not retain original car-
riage returns. To maintain the original carriage re-
turns, make sure the [Box Text] and [Wrap Text]
options are deselected.

Data tags

Ef’

ElixirForm allows you to add, edit and view Data tags
for use with DocuTag or DataMerge software.

See your DocuTag User Guide or DataMerge User
Guide for detailed information.

Editing text

When editing text, the name of the font used to create
the text highlights in the Font Preview Panel. You
must select a text block before you can edit it.

To select a text block:

1. Select the Toolbox Select/Edit tool.
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You can also change to select mode by right-
clicking on the text. However, if you are still in add
text mode, this right-click ends text entry; you
must right-click again to change to select mode.

Place the cursor on the text block you want to
edit, then right-click.

The Text toolbox displays.

See the "Keyboard shortcuts" section for use when
editing text.

Changing text attributes

To change the attributes of a selected text block, se-
lect Text toolbox icons. Each new attribute applies to
the selected text block.

Changing fonts

To change the font in a text block:

1.

Select the text block, then right-click.
The Text toolbox displays.

Place the cursor at the beginning of the text
block.

Select a font from the Font Preview Panel.

The new font applies to all text in the text block.

When you change the font as described above, a hid-
den control character adds before the changed text
which contains font information. You can delete this
character to change the text back to its original font.

Replacing fonts

To replace every occurrence of a font:

1.

Select the font to replace in the Font Preview
Panel.
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2. Select [-] in the [Text - Add/Remove Font from
list] option.

Depending on font type being replaced, the Select
ATM font, Select TrueType font or Replace Font
dialog box displays.

3. Select a replacement font, then click on [OK].

If the replacement font is not currently in use on
the form, all occurrences of the font are replaced
by the new font.

If you click on [-] and the font is not in use in the docu-
ment, the font removes from the font list. See "Adding
or removing a font" for more information on removing
a font.

Applying multiple fonts to a text block

When editing text, the name of the font used to create
the text highlights in the Font Preview Panel. If multi-
ple fonts are used, the highlighted font changes as
you place the cursor on different fonts.

All fonts in the text block must have the same orienta-
tion. To use a font with a different orientation, place
the cursor at the beginning of the text block and apply
the orientation to all fonts within the block.

To change a font location to the end of the text block:
1. Select the text block, then right-click.

2. Place the cursor where you want the new font
to start, then click.

3. Select a font from the Font Preview Panel.

All text after the cursor changes to the selected
font.

To change the font of a word or phrase in a text block:
1. Select the text block, then right-click.

2. Select the word or phrase to change.
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Joining text

3.

Select a new font from the Font Preview
Panel.

The selected text displays in the new font.

Splitting text

ElixirForm allows you to rejoin text separated during
form conversion to .ELX format.

To join text:

1.

Select [Text/Font Options] from the Options
menu.

The Text and Font Options dialog box displays.

Select a [Join Text Using] option: [Spaces],
[Justify] or [Relative], then click on [OK].

See the "ElixirForm defaults" chapter for informa-
tion on the Text and Fonts Options dialog box.

Group the text you want to join.

See the "ElixirForm basics" chapter for informa-
tion about defining a group.

Select the [Join Text] option.

The text in the group joins.

To split a text block into two separate blocks:

1.

Select the text block to split, then right-click.
The Text toolbox displays.

Place the cursor where you want to split the
text.

Select the [Text - Split String] option in the
Text toolbox.

The text splits and the cursor displays in the up-
per left corner of the new text block.
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Moving text

See the "Moving text" section for information on repo-
sitioning the text block.

ki

You can move a text block either before or after enter-
ing text.

Manually

To manually move a text block:

1.
2,

Select the Toolbox Select/Edit tool.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

Select the text block to move.
The cursor changes to a hand.

Click and drag the text block to where you
want it on the form.

Release the mouse button to accept the text
position.

Changing dimension coordinates

You can also move the text block by entering new di-
mension coordinates:

LT 128
x 1.62 1. Select the Toolbar Current Object - Start
Coordinates area.
If you cannot click on this area, select the line
again, then right-click.

2. Backspace over the current values or press
the <Del> key to delete the current values,
enter new coordinate values, then press
<Enter>.

The text adjusts to the new coordinates.
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Copying text

To copy a text block:

L“i 1. Select the Toolbox Select/Edit tool.

% 2. Select the Toolbox [Copy] option.

‘:IEH 3. Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

4. Select the text block to copy.

Brackets appear around the text to show it is se-
lected.

1:|Eﬁi‘ 5. Enter a value or click on the up or down
arrows to select the number of copies
between 1 and 99.

Hold down the <Ctrl> key while clicking on the ar-
rows to increase or decrease the value by 10.
You can also backspace over the value and enter
a new value from the keyboard.

6. Drag the block of text in the direction you
want to place the copies.

7. Release the mouse button at the desired loca-
tion.

The copies lock into position in the Work area.

Cutting, copying and pasting text

ElixirForm uses hot-keys to cut and paste selected
text.

To cut or copy and paste text:

[} 1. Select the Toolbox Select/Edit tool.

2. Right-click on the text block.
3. Select the text to be cut or copied.

4. Press <Ctrl> + <X> to cut text; press <Ctrl> +
<C> to copy text.
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Deleting text

5.
6.
7.
8.

Right-click to end text selection.
Select the Toolbox Text tool.
Click the cursor at the new location.

Press <Ctrl> + <V> to paste text.

To delete a text block:

To

Select the text to delete.
Press <Del>.
The selected text block deletes.

restore deleted text, immediately select [Undo]

from the Edit menu, click on the Toolbar Undo icon or
press <Ctrl> + <Z>.

Finding/replacing text

ElixiForm allows you to replace occurrences of
word(s) on a form and to find text and non-standard
keyboard characters.

Finding

To find text:

1.

Select [Find] from the Edit menu.
The Find Text dialog box displays.

Enter the tes to find in the [Find Text] option,
then click on the [Find] button.

To find non-standard keyboard characters:

1.

Select [Find] from the Edit menu.

The Find Text dialog box displays.

7-20

ELIXIR TECHNOLOGIES CORPORATION



TEXT OPERATIONS

2. Enter the decimal value (from the Windows
character mapping table) of the character in
the [Find Text] option, then click on the [Find]
button.

The Find Text dialog box contains the following
options:

Find Text
Enter a search text string or select a previously-used
string from the drop-down list.

Case Sensitive
Searches for text with the same capitalization as the
text in the [Find Text] option.

Whole Words
Searches for complete words that match the text in
the [Find Text] option.

For example, searching for “the” returns only “the” -
not words containing “the”, such as "there”.

Find
Searches the open form for the text selected/entered
in the [Find Text] option.

Cancel
Closes the Find Text dialog box.

Help
For future implementation.

After initiating a Find session, press <Ctrl> + <F3> to

find the next occurrence of [Find Text] text, and <Ctrl>
+ <Shift> + <F3> to find the previous occurrence.

Replace

To replace occurrences of a word:
1. Select [Replace] from the Edit menu.
The Replace Text dialog box displays.

2. Select/enter search and replace options, then
click on the [Replace] or [Replace All] button.
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The Replace Text dialog box contains the following
options:

Find text
Enter a search text string or select a previously-used
string from the drop-down list.

Replace by
Enter a replacement text string or select a previously-
used string from the drop-down list.

Case Sensitive
Searches for text with the same capitalization as the
text in the [Find text] option.

Whole Words
Searches for complete words that match the text in
the [Find text] option.

For example, searching for “the” returns only “the” -
not words containing “the”, such as "there”.

Replace
Replaces the text in the [Find text] option text with the
text in the [Replace by] option.

Replace All
Replaces all instances of the text in the [Find text] op-
tion text with the text in the [Replace by] option.

Cancel
Closes the Replace Text dialog box.

Help
For future implementation.

Spell checking

If installed, the ElixirForm Spell Checker option allows
you to identify misspelled words in your form.

Setting defaults

To set spell check defaults:
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1. Select [Spell Check Options] from the Options
menu.

The Spell Check Options dialog box displays.

e NI nlich Standard =]

Dialect/mode: | US English jl

Lexicon Supplements:

_ | Business/Insurance/Finance | Legal
| Medical _ | Science

/| Provide Alternatives If Not Found
| Provide Alternz. From Perzonal Dictionary

| Perform Space Insertion ¢ ok
+| Remove Final Period
Personal Dictionaries:

annceI

= (=
a |o
o £

s v

@

=l

Hemove I

Edit |

| __| Spell Check Typing

Figure 7-3. Spell Check Options dialog box
2. Select spell check options, then click on [OK].

The Spell Check Options dialog box contains the fol-
lowing options:

Language
Select the language to use from the drop-down list.

Dialect/mode
Select the dialect/mode for the selected language
from the drop-down list.

Lexicon Supplements
Select a terminology dictionary:

® [Business/Insurance/Finance] - contains busi-
ness, insurance, or financial terminology

® [Medical] - contains medical terminology
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® [Legal] - contains legal terminology
® [Science] - contains scientific terminology

Processing Correction Defaults
These options are used only when errors are found:

® [Provide Alternatives If Not Found] - provides al-
ternative words if a word is not found in the
database

® [Provide Alterns. From Personal Dictionary] - pro-
vides alternative words from active personal dic-
tionaries after alternatives from the active
database are retrieved

e [Perform Space Insertion] - inserts spaces be-
tween incorrectly spaced words; For example, the
string "andthe" is corrected to "and the".

®* [Remove Final Period] - strips the final period
from a word before it is submitted for correction

Personal Dictionaries
Displays the dictionary files (*.RD) available for use.

New
Enter a name for the new personal dictionary in the
Create Personal Dictionary dialog box.

Add

Select an existing personal dictionary (*.?D) dictionary
to add to the Personal Dictionaries field in the Add
Personal Dictionary dialog box.

Remove
Removes the selected dictionary from the Personal
Dictionaries field.

Edit
Edits entries in the dictionary selected in the Personal
dictionaries field.

Click on the [Add], [Delete], or [Replace] button to per-
form the appropriate action for the word that displays
in the Edit word field in the Edit Personal Dictionary
dialog box.
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Spell Check Typing

Activates the spell check option after a word is typed.
Once a word is entered and the space bar is de-
pressed, the word is spell checked.

Using the Spell Checker

To use the ElixirForm Spell Checker:

1.

Click on the Toolbar Spell Check icon or
select [Spell Check] from the Tools menu.

The Spell Checker checks all text in the current
form for misspelled words.

If Spell Checker does not recognize a word, the
Spell Check dialog box displays. The unrecog-
nized word displays in the [Edit] option; the possi-
ble correct word displays in the [Guess] option.

If the word displayed in the [Guess] option is
not correct, select an alternative word from
the drop-down list.

If the word is not found in the drop-down list,
place cursor in the [Edit] option, backspace
over the misspelled word, then enter the
correct spelling.

Select one of the following options:

Replace
Replaces the misspelled word with the text in the
[Edit] option.

Replace All
Replaces all instances of the misspelled word
with the text in the [Edit] option.

Ignore
Ignores the first occurrence of the text in the [Edit]
option.

Ignore All
Ignores all occurrences of the text in the [Edit]
option.
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Stop
Stops spell checking and closes the Spell Check
dialog box.

A 'beep’ indicates when a spell check operation
completes.

Keyboard shortcuts

ElixirForm uses the following fast keys for the text op-
erations described in this guide:

<Left arrow> Move cursor left one character
<Up arrow>  Move cursor up one line
<Right arrow> Move cursor right one character

<Down arrow> Move cursor down one line

<Home> Move cursor to start of line
<End> Move cursor to end of line
<Ctrl> +

<Left arrow> Move cursor left one word

<Ctrl> +
<Right arrow> Move cursor right one word

<Ins> Insert/Overwrite toggle
<Del> Delete character right
<Backspace> Delete character left
<Ctrl> + <Del> Delete next word

<Ctrl> +
<Bksp> Delete previous word

<Ctrl> + <E> Delete to end of text block

<Ctrl> +
<End> Move cursor to end of text block
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<Ctrl> + <K>

<Ctrl> +
<Home>

<F11>

<Ctrl> + <T>
<Ctrl> + <X>
<Ctrl> + <C>

<Ctrl> + <V>

Delete to end of line

Move cursor to start of text block
Lock/free text

Show/hide data tags

Cut text

Copy text

Paste text
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8. Images

ElixirForm uses Full-color and black-and-white Elixir-
format images. You can use the Elixir Desktop to con-
vert .PCX and .TIF files to Elixir format.

Screen versions of images have .LW8 extensions and
reside in the drive\ELIXIR\PICS\SCREEN directory.
Printer versions of images have .LP3 extensions and
reside in the drive \ELIXIR\PICS\PRINTER directory.

For more information about creating Elixir-format im-
ages, see the Elixirlmage for AFP User Guide.

Loading an image

You can load a maximum of 16 images or logos to a
form. The size allowed for an image depends upon
the amount of available Windows memory and the ca-
pability of your printer.

% To add an image to your form:

1. Select the Image tool in the Toolbox.

The Image toolbox displays.
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Figure 8-1. Image toolbox

If an image is already loaded, the image name,
coordinates, and an image preview also display.

@ 2. Select the Toolbox [Load Image] option.

The Load Image dialog box displays.

ehxiripics\scieen

fhlngn Iwd

Figure 8-2. Load Image dialog box
3. Select an image, then click on [OK]

4. Press and hold the mouse button.
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The image attaches to the screen pointer.

Position the image on the form, then release
the mouse button.

The image locks into place.

Editing images

You can only edit images using Elixirlmage software.
See your Elixirlmage for AFP User Guide for more
information.

Moving an image

You can move an image on your form either manually
or by entering new position coordinates.

Manually

To move an image manually:

Rl 4

2,

Select the Select/Edit tool in the Toolbox.
Select the image to move.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

Click and drag the image to the new location.
Release the mouse button

The image locks into position.
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).

1.28
1.62

Changing dimension coordinate

To move an image by entering new dimension coordi-
nates:

1.

Select the Toolbar Current Object - Start
Coordinates area.

If you cannot click on this area, select the line
again, then right-click.

Backspace over the current values or press
the <Del> key to delete the current values,
enter new coordinate values, then press
<Enter>.

The image moves to the new coordinates.

Copying an image

R

To copy an image:

1.
2,

Select the Toolbox Select/Edit tool.

Select the image to copy.

Boxes appear around the image when selected.
Select the Toolbox [Copy] option.

Click on the up and down arrow to specify
number of copies.

Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

Click and drag the image in the direction you
want the duplicate images to display.

Release the mouse button to lock the images
in place.
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Deleting an image

To delete an image:
1. Select the Toolbox Select/Edit tool.

2. Select the image you want to delete, then
press <Del>.

To immediately undo the delete operation, either click
on the Toolbar Undo icon or select [Undo] from the
Edit menu
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9. Stand-alone utilities

This chapter describes the Elixir stand-alone batch
utilities provided with ElixirForm. These utilities copy
to the drive\ELIXIR directory during installation (drive:
is the drive on which you installed your Elixir
software).

Using the utilities

The parameters required to run each utility display on
your screen when you enter the utility name from the
drive:\ELIXIR directory.

Most utilities accept DOS wildcard characters (see
your DOS documentation for instructions on the
proper use of wildcards). When using wildcards, spec-
ify only the desired file(s).

For optional parameters enclosed in brackets [ ], the
first parameter is the default.

When specifying utilities, either do not specify pa-
rameters to use the parameter default or specify all
the parameters. You cannot skip parameters.

All utilities link to Desktop operations through dialog
boxes (note that not all utility options are available
from the Desktop dialog boxes). Note that applica-
tion-specific utilities must be run on the command line
using the DOS pull-down menu or the Dispatcher
icon.

Add drive:\ELIXIR to the DOS PATH= statement in
your AUTOEXEC.BAT file to ensure that DOS
searches the drive\ELIXIR directory for the batch util-
ity. For details on setting up the PATH= statement,
see your DOS manual.
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AFPVIEW

Usage

Directory
information

The AFPVIEW utility displays the contents of AFP-
format OVE, page segment and font files in hexideci-
mal and ASCIl masked format.

AFPVIEW filename.ext <Enter>

filename.ext
is the AFP file name and extension.

Run AFPVIEW from the directory in which the AFP file
to be viewed resides.

OVE files are in
drive \ELIXIR\FORMS\OVEIN or
drive AELIXIR\FORMS\OVEOQOUT.

Page segment files are in
drive:\ELIXIR PICS\SEGIN or
drive\ELIXIR\PICS\SEGOUT.

Bounded-box fonts are in
drive:\ELIXIR\FONTS\AFPIN or
drive \ELIXIR\FONTS\AFPOUT
Unbounded-box fonts are in
drive:\ELIXIR\FONTS\I38IN or
drive \ELIXIR\FONTS\I38OUT.

When the file contents display on the screen, use the
following keys:

® <pPage Up>, <Page Down>, <Home>, or <End>
scrolls through the pages

®  The up, down, right and left arrow keys moves the
cursor in the currently displayed page

® <J> and a number jumps to the entered page
number

®  <Alt> + <H> displays on-line Help

® <Alt> + <X> exits the screen and returns to DOS
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FONTCHG

The FONTCHG utility does the following:

e  Strips the two left characters from Elixir-format
form files names

®  Substitutes fonts in an Elixir form with fonts you
specify in a font list

® Lists information about fonts in an Elixir-format
form

Usage FONTCHG filename [fontlist][-LIST]<Enter>

filename
is the Elixir-format form file name, with or without the
.ELX extension. Wildcards are allowed.

fontlist

is the full name and path of an ASCII font list file
Wildcards are not allowed. Each line of the font list file
contains a pair of Elixir fonts separated by a space.
When running the utility, fonts in the first column are
substituted with the corresponding font from the sec-
ond column.

-LIST

displays a list of .ELX files specified by filename, and
for each .ELX file, lists the fonts used in the form. A
list of all fonts used in multiple forms (when using wild-
cards for filename) also displays.

Directory
information Run FONTCHG from the directory in which the files to
be converted reside. If you have not specified
drive\ELIXIR in you DOS PATH= statement, precede
the FONTCHG command with drive:\ELIXIR.

Example To substitute fonts in the Elixir form MARK.ELX with
the fonts in the CHAD.LST ASCII font file list, type:

1. CD \ELIXIR\FORMS\ELIXIR <Enter>

The current directory (on the current drive)
changes to \ELIXIR\FORMS\ELIXIR.
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2. FONTCHG MARK.ELX
C:\ELIXIRIFORMS\ELIXIR\DEMO
CHAD.LST <Enter>

This command substitutes the fonts in the Elixir
form MARK.ELX with the fonts specified in the
ASCII font list file CHAD.LST in the \ELIX-
IR\FORMS\ELIXIR\DEMO directory.

(The fonts used in the form MARK.ELX are entered in
the first column of the ASCII font file, and the desired
substitution font is entered in the second column of
the file across from the font it will replace.)

FORMPRN

Usage

The FORMPRN utility prints Elixir format forms in
batch mode using MS-DOS commands.

FORMPRN [ﬁath] filename HP]
printer | disk] [cop |esJ [ASCII] [macronum-
er] [traynumber] [land] <Enter>

path
is the optional DOS path name.

filename
is any DOS file name, including the file extension.
Wildcards are allowed.

HP
is the optional printer type. (Only HP printer type is
supported in this release)

printer/disk
is the destination of the output file to a printer or
diskette.

copies
is the number of copies to be printed. The default is 1.
Note that font files are sent with every copy.
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ASCII

is the printer interface. Currently, only the ASCII inter-
face is supported. Omitting or including this parame-
ter has no effect.

macronumber
is the macro number used for HP printers. 0 = None.

traynumber
is the output tray number for printers supporting this
feature. The default tray is 0.

land
forces the orientation to landscape (for HP printers

only).

FORMPRN produces a .PRN file containing PCL 4
statements in ASCII format.

Directory
information Run FORMPRN from the drive\ELIXIR directory.
FORMPRN searches the default forms directory (usu-
ally drive\ELIXIR\FORMS\ELIXIR\DEMO) as speci-
fied in the ElixirForm configuration file.

IC

The IC utility converts .LP3, .PCX, and .TIF format im-
age files to .LP3, .PCX, screen or .TIF format files.

Note that all options are preceded by a hyphen ("-")
and can be entered in any order.

Usage IC sourcefile [informat] [outformat] [-Dnn] [-Faaa]
[-Wa] [-Rnnn] [-Xnnn] [-Ynnn][-Saaa] <Enter>

sourcefile
is the filename of the source image. Wildcards are
allowed.

informat
is the name of the source image format: ELIXIR,
PSEG, PCPAINT, or TIFF.
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ELIXIR represents Elixir (.LP3) format image files. To
convert an Elixir image file, it must be in the
drive:\ELIXIR\PICS\PRINTER directory.

PCPAINT represents PCX format files. To convert a
PCX file, it must be in the drive:\ELIXIR\PICS\PCXIN
directory.

TIFF represents TIFF (.TIF) format files. To convert a
TIFF format file, the file must be in the
drive:\ELIXIR\PICS\TIFFIN directory.

outformat
is the name of the target image format: ELIXIR,
PSEG, PCPAINT, TIFF, or SCREEN.

ELIXIR creates an output image in Elixir (.LP3) image
format. The output .LP3 file is written to the
drive:\ELIXIR\PICS\PRINTER directory. A screen ver-
sion (.LW8) of the file is also created in the
drive:\ELIXIR\PICS\SCREEN directory.

PCPAINT creates a PCX format image file in the
drive:\ELIXIR\PICS\PCXOUT directory (black-and-
white only).

TIFF creates TIFF (.TIF) format files in the
drive:\ELIXIR\PICS\TIFFOUT directory (black-and-
white only).

SCREEN creates Elixir screen format (.LW8) versions
of a image file that work with the image in ElixirForm.
The output file is created in the
drive:\ELIXIR\PICS\SCREEN directory.

-Dnnn
specifies the output resolution in dots per inch: 300 or
240.

-Faaa
is the output record format for AFPDS output: VBM,
AS400, IRMA, OS2, or MODCA.

-Wa
Y removes, and N does not remove white space from
an AFP page segment.

-Rnnn
the number of degrees to rotate pages.
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-Xnnn
the horizontal offset in pels.

-Ynnn
the vertical offset in pels.

-Saaa
allows you to specify your monitor type: VGA, SU-
PERVGA, SIGMA, or WYSE.

Directory
information The current directory changes to drive:\ELIXIR to run

IC unless you have included drive:\ELIXIR in a DOS
PATH= statement.

Example To input an Elixir-format file named FBLOGO and cre-
ate a PSEG-format file, type:
1. CD \ELIXIR <Enter>
The current directory changes to drive:\ELIXIR where
the IC utility resides.
2. IC FBLOGO ELIXIR PSEG -FVBM

-D240 -WN <Enter>
The Elixir-format file converts to PSEG format.
SF
The SF utility converts Elixir-format font files to screen
font files. Use this utility to create screen fonts from
Elixir-format files that are larger than 64 KB, or if a
low-memory warning message displays when creating
screen fonts with ElixirForm.
Usage SF filename [monitor] <Enter>

filename
is the name of the source Elixir font.

monitor

allows you to specify your monitor as one of the fol-
lowing: SIGMA, WYSE, VGA, XEROX or SU-
PERVGA. These options resize the font bitmap for the
correct screen.
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Directory
information Run SF from the directory in which the input files re-
side. If you have not specified drive:\ELIXIR in your
DOS PATH= statement, precede the SF command

with drive:\ELIXIR\.
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Keyboard shortcuts

This appendix lists keyboard shortcuts (fast keys) in

ElixirForm.

Command
Copy
Crosshair on/off
Cut

Delete

Delete all

Exit

Grid on/off

Help

Hide work area
Hide/show data tags
Load form
Lock/free text
New form
Paste

Quick save
Redo

Ruler on/off

Save form

<Ctrl> + <C>
<F6>

<Ctrl> + <X>
<Del>
<Ctrl>+<Del>
<Alt>+<F4>
<F4>

<F1>

<Ctrl> +<F4>
<Ctrl> + <T>
<F8>

<F11>

<F9>
<Ctrl>+<V>
<Ctrl> + <S>
<Shift>+<Ctr|>+<zZ>
<F3>

<Ctl>+<S>
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Save form as
Screen refresh
Select/unselect all

Shift element

Snap to grid
Sticky lines
Toolbox show/hide

Undo

Text editing keys:
Copy text

Cut text

Delete character left
Delete character right
Delete next word
Delete previous word
Delete to end of line

Delete to end of
text block

Find
Find Next

Find Previous

<F7>
<*> (on the numeric keypad)
<Ctl>+<A>

<Ctrl>+ Left/Right/Up/Down
arrow keys

<F5>
<Ctrl> + <L>
<F10>

<Ctrl>+<Z>

<Ctrl> + <C>
<Ctrl> + <X>
<Backspace>
<Del>

<Ctrl> + <Del>
<Ctrl> + <Bksp>

<Ctrl> + <K>

<Ctrl> + <E>
<Alt> + <F3>
<F3>

<Shift> + <F3>

Find Selected (forward) <Ctrl> + <F3>

Find Selected (reverse) <Ctrl> + <Shift> + <F3>

Insert/Overwrite toggle <Ins>
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Lock/Free text <F11>

Move cursor down
one line <>

Move cursor left
one character <&>

Move cursor right
one character <>

ove cursor up
one line <N>

Move cursor left
one word <Ctrl> + <&>

Move cursor right
one word <Ctrl> + <>>

Move cursor to
end of line <End>

Move cursor to
start of line <Home>

Move cursor to
end of block <Ctrl> + <End>

Move cursor to
start of block <Ctrl> + <Home>

Paste text <Ctrl> + <V>

Show/hide data tags  <Ctrl> + <T>

Numeric display box keyboard shortcuts

The following fast keys are used for editing numbers
in numeric display boxes (such as the tool width op-
tion). Numbers are entered from right to left, similar to
a pocket calculator.

For all but the first two fast keys, you must first acti-
vate edit mode by clicking in the display box.
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Change decimal
value

Change integer value

Define value as
negative

Delete number
(setto 0)

Delete right digit
Edit (toggle)

End integer and start
decimal value

Finish editing
Reset

Reset and
finish editing

Zoom/Pan controls:
Pan left

Pan up

Pan right

Pan down

Zoom in

Zoom out

Top left of form<Home>

Bottom left of form
Top right of form

Bottom right of form

Click on arrows (where
provided)

<Ctrl> + click on arrows

<Del>
<Bksp>

Left click

<.> (dot)
<Enter>

<Alt> + <Bksp>

<Esc>

<&>
<PN>
<>

<End>
<Ctl> + <PgUp>

<Ctrl> + <PgDn>

A4
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Scroll up <PgUp>
Scroll down <PgDn>

Locate; redraw
with new center point  <*>

The above fast keys also use the keys on the numeric
keypad with <Num Lock> off.

ELIXIRFORM FOR AFP USER GUIDE A-5



Glossary

This glossary provides a list of the basic terms used in
this guide.

Application: Any program you run on your PC. Elixir
applications are represented by icons on the Elix-
irForm/Elixir Desktop. If an Elixir application is not in-
stalled on your PC, its icon does not display.

Arrow: An arrow-shaped screen pointer used for se-
lecting objects.

Boxed text: Text on a form that is bound by a column
with a set height and width.

Button (on the screen): An area on the screen that
causes a response when you click on it. For example,
an [OK] button that accepts your entries when you
click on it in a dialog box.

Click, on an item: To momentarily press and release
the left mouse button with the screen pointer on an
item.

Close: To exit from a window, dialog box, application,
or the Desktop.

Close box: A small white box at the left of a window
header and at the left of the menu bar. Clicking a
close box on a window header closes the window.
Clicking a close box on the menu bar exits the
Desktop.

Command button: A button in a dialog box that con-
firms or cancels an action when you click on it. The
[Cancel] button cancels the command. The [OK] but-
ton confirms and executes the command and saves
the information you specified in a dialog box.
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Converter icon: The icon that converts font, form, im-
age and document files to and from different formats.

Cursor: A screen pointer used when entering text in
the work area or in a dialog box.

Desktop: The Elixir Desktop working environment,
consisting of the menu bar, the screen area and icons
on the screen.

Dialog box: A rectangular box that displays and re-
guests information. You enter information in fields in
the dialog box, and normally confirm your entries by
clicking on an [OK] button or by pressing <Enter>.

Directory: A list of hard disk or diskette contents.
Desktop directories are represented by folder icons.
Folder contents can be viewed pictorially, alphabeti-
cally, by icon, by size, or by date.

Dispatcher icon: The icon in the Elixir Desktop that
stores and invokes a number of DOS commands.

DOS: Disk Operating System, the collection of pro-
grams that gives control of a PC's resources to the
user.

Double-click: To press the left mouse button twice in
rapid succession, normally to open an icon.

Drag: To click on an item and move the item with the
mouse while holding down the left mouse button.

Drag and drop: A method used to copy an object as
follows: click on an item on the screen, hold down the
left mouse button, move the mouse to move the
screen pointer to an icon, then release the mouse
button.

Drop: To release the mouse button after dragging an
item to an icon.

Elixir folders: The folders represented by the four
top left icons on the Desktop: the Forms, Fonts, Im-
ages and Documents folders. Each of these folders
contains a subordinate Elixir, Input and Output folder.
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Extension: The period and three characters following
a file name. An extension identifies the type of infor-
mation in a file. For example, .ELX indicates an Elixir
format form file.

Fast Keys: See Keyboard shortcuts.

File filter: The use of DOS wildcard characters to dis-
play only those files with selected name characteris-
tics in a window or dialog box. For example, to display
only files that begin with ABC in a directory of many
files you could enter ABC**. See also, Wildcard
character.

File name: The name of a file. The ElixirForm/Elixir
Desktop uses DOS file naming conventions. DOS file
names consist of a base (stem) name containing up to
eight characters and an extension of up to three
characters.

Folder icon: The Desktop icon representing a DOS
directory. Folders allow you to quickly organize infor-
mation on the Desktop.

Format: To prepare a diskette so it can hold informa-
tion. Formatting a diskette erases the information on
the diskette.

Form elements: The individual lines, shapes, images,
and text that compose a form. You can create,
change, move, copy, delete, import, or load a form
element.

Form template: A form loaded as an overlay or visual
guide only for the purpose of designing new form ele-
ments around it. A form template does not become
part of the form when the form is saved, only the new
elements added are saved with the form.

Free text: Text on a form that is not bound by a col-
umn with a set height and width. The width of the form
is the only restriction.

Grayed options: Grayed options are menu options
you cannot choose because they do not apply to your
current selection. Also called dimmed options.
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Head to head: In duplex printing, when the page top
is printed in the same position on both sides of the

page.

Head to toe: In duplex printing, when the top of one
side of the page is printed in the same position as the
bottom of the other side of the page.

Highlighted: A highlighted option appears darkened
on the screen, and indicates that it is selected.

Icon: A small, roughly rectangular-shaped symbol on
the Desktop that represents an application, a file, a
folder, or a peripheral device.

Importing files: The process of copying non-Elixir
format files from different storage media (such as a
hard disk, a diskette, or tape) to the appropriate Desk-
top input folder or to the Work area.

Information box: A white square at the right of the
menu bar identified with an "i". Clicking on the infor-
mation box displays information about the open Elixir
Desktop application.

Inverse Landscape: The orientation of fonts, logos,
or images on a page. See the definition for portrait for
a figure describing the orientation of fonts on pages.

Inverse Portrait: The orientation of fonts, logos, or
images on a page. See the definition for portrait for a
figure describing the orientation of fonts on pages.

Kerning: Adjusting the spacing between characters to
make certain letters appear better fitted together and
more attractive on the page.

Keyboard shortcut: Also called Fast keys. A special
one- or two-key combination that allows you to exe-
cute an option without using the mouse. Keyboard
shortcuts are shown on each menu beside the name
of the option and are listed in the “Keyboard shortcuts”
appendix.

Landscape: The orientation of a page or the fonts, lo-
gos, or images on a page. A landscape page is nar-
rower on the sides than on the top. See the definition
of portrait for a figure describing the orientation of
fonts on pages.
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Menu: A list of options from which you make a selec-
tion to perform an action. A menu displays when you
select a menu title from the menu bar or from a win-
dow header, or when you click on an option.

Menu bar: The horizontal bar displayed at the top of
the Desktop from which you access pull-down menus.

Menu titles: Text that identifies a menu, displayed in
a window header or on the menu bar.

Message area: A bar just below the menu bar that
displays error messages or information about the ac-
tivity you are performing.

Mouse button: A button on the top of the mouse.
ElixirForm uses the left and right buttons of a mouse.

Multi-select: Selecting more than one file or icon by
shift-clicking on them.

Open a folder, Elixir file, application, or peripheral
device: 1.) Opening a folder icon displays a window
showing the contents of the folder. 2.) Opening an
Elixir file icon starts the application that created the file
and loads the file . 3.) Opening an application icon
starts the application. 4.) Opening a peripheral device
displays a dialog box allowing you to set the device
parameters.

Option: A word or phrase in a menu that you can
select.

Peripheral (device): A printer, scanner, or tape drive
connected to your PC.

Point: To move the mouse so the screen pointer (in
most cases an arrow) rests on the desired item.

Portrait: The orientation of a page, or the fonts, lo-
gos, or images on a page. A portrait page is narrower
on top than on the side (like pages in this book). See
the following figure for the orientation of fonts on
pages.
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Orientation of fonts on Portrait (left) and
Landscape pages

Printer icon: An icon representing a proof printer con-
nected to your PC.

Pull-down menu: See menu.

Raster graphics: Pictures composed of bit maps,
where each element of the picture is a dot defined as
black or white.

Replaceable parameter: A parameter (usually %1)
used in commands to represent a selected file name.
The selected file name replaces the parameter during
certain operations.

Run: To execute or start an application.

Scanner icon: The icon representing a scanner con-
nected to your PC.

Screen pointer: A pointer shaped like an arrow that
displays on the screen, and which you can move by
rolling the mouse on a flat surface.

Screen version: The version of a color or font com-
posed such that its appearance on a screen display is
as close as possible to its appearance when printed.

Scroll: To move a directory list in a window so you
can view different parts of the list.
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Scroll bar: A bar displayed on the right side of some
windows used for scrolling. The scroll bar contains a
scroll arrow, [+] and [-] buttons, and a slider bar that
moves within the scroll box.

Select: To click on an object, menu option, or form
element. A selected item appears highlighted.

Shift-click: To click on an object while holding down
the <Shift> key. Usually used to select multiple
elements.

Slider bar: A bar in the scroll box at the side of some
windows that scrolls items in the window when you
drag it up and down.

Snap to: A function that causes form elements to
automatically align with the nearest grid point when a
grid is displayed in the Work area.

Tape icon: The icon representing a tape drive con-
nected to your PC.

Trashbin icon: The Trashbin icon is in the lower right
corner of the Desktop and represents a receptacle for
items you want to delete. You delete a file by dragging
it to the Trashbin icon.

UDK: (User Defined Key) a substitute escape charac-
ter defined by a user for specific print jobs

Unselect: To cause one or more selected (high-
lighted) icons or elements to not be selected any
more. The quickest way to do this is to click on an-
other area of the Desktop or Work area.

UserTools icon: The icon that links applications to
files.

Utilities: Special-purpose applications with which you
can perform functions from the DOS prompt.

Wildcard character: A character in a file name, usu-
ally an asterisk (*), that specifies a matching set. For
example, *.EXE represents all files that end with the
.EXE extension.
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Window: A rectangular area on your screen in which
you view information, such the contents of a folder. All
windows contain a window header. Some windows
have scroll bars along the right side.

Window header: The top of a window that displays
the DOS directory corresponding to the window con-
tents. Some window headers also show a close box
and a number of menu titles with pull-down menus.
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A

adding multiple fonts,
7-16
AFPVIEW, 9-2

B

boilerplate, 1-1

Box toolbox
box - border/split
thickness and style,
2-8
box - color, 2-9
box - corner radius,
2-10
box - fill color, 2-9
box - horizontal
splits, 2-9
box - line/border
style, 2-8
box - positioning,
2-7
box - shape, 2-8
box - vertical splits,
2-9
box predefined
shape, 2-7
custom line/border
thickness, 2-8
diagonals, 2-8
object fill
pattern/shading, 2-9

boxes, 5-1
corner radius, 6-7
corner style, 6-5
drawing, 6-3
positioning, 6-5

Cc

Index

shading, 6-7
shape, 6-5

with diagonal lines,
6-5

Character Mapping Op-
tions dialog box, 3-8
Circle toolbox

circle - border style,
2-11

circle - color, 2-11
circle - diagonals,
2-10

circle - drawing
method, 2-10

circle - fill color, 2-11
circle - radius, 2-10
circle - start and fin-
ish angle, 2-11
circle axis, 2-12
custom line/border
thickness, 2-11
object fill
pattern/shading,
2-11

circles

border styles, 6-9
diagonals, 6-9
drawing, 6-7
radius, 6-8
start/finish angle,
6-9

column height, 7-5
column width, 7-5
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conventions, 1-5
copying

images, 8-4
copying elements, 5-6
crosshair, 4-6
Current object - Dimen-
sions, 2-18
Current object - Shape,
2-18
Current object - Start
Coordinates, 2-18

D

DAT file
defined, 3-3
opening, 3-3
default
settings, 4-7
Delete Form dialog box,
3-2
deleting
a form, 2-31
elements, 5-7, 7-20
images, 8-5
Desktop
Help, 1-6
Help menu, 1-6
dialog box
Character Mapping
Options, 3-8
Delete Form, 3-2
Filing Options, 3-3,
4-20
Find Text, 3-6
GEM Forms Load
Defaults, 3-7, 4-15
Grid Setting, 2-19,
4-1, 4-2
Import Text, 3-3
Load Form, 3-1
Load Form Group,
3-2
Load Form Tem-
plate, 3-2
Objects Off Page,
4-9, 4-10
Open Dat File, 3-3

Page Databasing,
3-7,4-11
Page Properties,
3-1, 3-7, 4-7
Print, 3-3
Rename/Move
Form, 3-2
Replace text, 3-6
Ruler Options, 2-19,
4-5
Save Form As, 3-2
Save Form Group,
3-2
Spell Check Op-
tions, 3-11
Template Options,
2-25, 3-11
Text and Font Op-
tions, 3-7, 4-13
Usage Switches,
3-3,4-18
Digital ruler, 2-18, 4-4
DocuMerge, 7-14
DocuTag, 7-14

E

Edit menu, 3-5
Copy, 3-5
Cut, 3-5
Delete, 3-6
Delete All, 3-6
Deselect All, 3-5
Find, 3-6
Find Next, 3-6
Find Previous, 3-6
Paste, 3-5
Redo, 3-5
Replace, 3-6
Select All, 3-5
Undo, 3-5
editing
images, 8-3
multiple forms, 2-33
elements
adding, 2-26

INDEX-2
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editing, 2-27
excluding, 2-29
grouping, 2-28
shifting, 2-28
ElixirForm menu bar,
3-1
File menu, 3-1
Help menu, 3-4
System menu, 3-3
Window menu, 3-4
ElixirForm window, 2-1
exiting, 1-9, 2-36

F

fast keys, 2-35
File menu, 3-1
Close Dat File, 3-3
Delete Form, 3-2
Exit, 3-3
Import Text, 3-3
Load Form, 3-1
Load Form Tem-
plate, 3-2
Merge Form Group,
3-2
New Form, 3-1
Open Dat File, 3-3
Print, 3-3
Remove Form Tem-
plate, 3-2
Rename/Move
Form, 3-2
Save Form, 3-1
Save Form As, 3-2
Save Form Group,
3-2
filing options, 4-19
Filing Options dialog
box, 3-3, 4-20
Find Text dialog box, 3-6
font
adding multiple
fonts, 7-16
changing, 7-15
load font list, 7-9

merging a font list,
7-9
Font list, 7-8
adding fonts, 7-10
customizing, 7-9
loading, 7-9
merging, 7-9
removing fonts, 7-10
Font Preview Panel,
2-16, 7-8
FONTCHG utility, 9-3
form
creating, 2-22
deleting, 2-31
designing for enve-
lope, 2-22
designing new, 2-22
loading, 2-22
merged data, 2-22
modifying, 2-27
moving, 2-31
renaming, 2-31
reproducing existing,
2-22
saving, 2-27
template defaults,
2-25
template loading,
2-24
using color, 2-26
FORMPRN UTILITY,
9-4
forms
grouping multiple,
2-34
free text, 7-6

G

GEM forms, 2-23, 4-15

GEM Forms Load De-

faults dialog box, 3-7,

4-15

Graphic ruler, 2-19, 4-4
selecting options,
4-5

grid, 4-1
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displaying/hiding,
4-1
selecting properties,
4-2
use grid/inch, 4-5
Grid display, 2-19
Grid Setting dialog box,
2-19,4-1,4-2
grouping form elements,
2-28
groups
defining, 2-28
merging, 2-24
multiple forms, 2-34
saving, 2-30

H

hardware requirements,
1-7

help, 1-6

Help, on-line, 1-6

Help menu, 1-6, 3-4

IC UTILITIY, 9-5
Image toolbox
image- name, 2-17
image - color, 2-17
image - fill color,
2-17
image - load, 2-17
image - size, 2-17
images, 8-1
.LP3, 8-2
LW8, 8-2
copying, 8-4
deleting, 8-5
editing, 8-3
loading, 8-1
moving, 8-3
toolbox, 8-1
Import Text dialog box,
3-3
importing text

complete blocks,
7-12
into a box, 7-14
separate blocks,
7-13
inserting data tags, 7-14
inter-character spacing,
7-3
inter-word spacing, 7-3

J

joining text, 7-17

K

keyboard shortcuts,
7-26, A-1

L

landscape, 2-33
Line toolbox, 5-3
custom line/border
thickness, 2-5
line - color, 2-5
line - direction, 2-5
line - style, 2-5
lines, 5-1
changing, 5-4, 5-5
copying, 5-6
deleting, 5-7
direction, 5-3
displaying, 5-1
drawing, 5-2
editing, 5-3
moving, 5-6
style, 5-3
toolbox, 5-2
width, 5-3
Load Form dialog box,
3-1
Load Form Group dialog
box, 3-2
Load Form Template
dialog box, 3-2
loading
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.DAT files, 2-35
.LP3 images, 8-2
.LW8 images, 8-2
form template, 2-24
GEM forms, 2-23
images, 8-1
new forms, 2-23
saved forms, 2-23
Long Crosshair, 2-20
Long crosshair, 4-6

menu bar

ElixirForm, 3-1

Work area, 3-5
menu bars, 2-21
menus

Help, 1-6
merging groups, 2-24
modifying a form, 2-27
move form, 2-31
moving

images, 8-3
moving elements, 5-6
multiple forms

editing, 2-34

N

non-standard charac-
ters, 7-10

O

Objects Off Page dialog
box, 4-9, 4-10

OGL, 1-2

on-line Help, 1-6
on-line help, 1-6

Open Dat File dialog
box, 3-3

Options menu, 3-7

Page Databasing,
3-7

Page Properties, 3-7
Snap to Grid, 3-7
Spell Check Op-
tions, 3-11
Template Options,
3-11

Text/Font Options,
3-7

P

page databasing, 4-11
Page Databasing dialog
box, 3-7, 4-11
page properties, 4-7
Page Properties dialog
box, 3-1, 3-7, 4-7
page shift, 2-33
Path toolbox
custom line/border
thickness, 2-6
line/border style, 2-6
object fill
pattern/shading, 2-7
path- finish drawing,
2-6
path - beginning
style, 2-6
path - color, 2-6
path - connection ra-
dius, 2-7
path - direction, 2-6
path - end style, 2-6
path - fill color, 2-7
path - shape, 2-5
paths
border style, 6-3
border width, 6-3
direction, 6-3
draw/done mode,
6-3

Character Mapping, drawing, 6-1

3-8 locked, 6-2

GEM Forms Load shading, 6-3

Defaults, 3-7 styles 6’—3
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portrait, 2-33
print

disk file, 2-34
Print dialog box, 3-3
printer, 2-32

PCL 4, 2-32
proof printing, 2-32

R

Redo, 2-20
Rename/Move Form
dialog box, 3-2
rename form, 2-31
Replace Text dialog box,
3-6
ruler, 4-4
digital, 4-5
display units, 4-5
graphic, 4-5
Ruler Options dialog
box, 2-19, 4-5

S

Save Form As dialog
box, 3-2
save form group, 2-30
Save Form Group dialog
box, 3-2
saving a form, 2-27
Select toolbox
copy, 2-3
copy - horizontal dis-
tance, 2-4
copy - vertical dis-
tance, 2-4
delete, 2-3
group filter options,
2-3
movement selection,
2-3
number of copies,
2-3
sticky lines, 2-4
SF UTILITY, 9-7
shapes

changing attributes,
6-11
changing size, 6-10
copying, 6-12
deleting, 6-13
drawing, 6-1
editing, 6-10
moving, 6-12
moving changing di-
mension coordi-
nates, 6-13
moving manually,
6-12
shifting elements, 2-28
Show/hide Toolbox,
2-21
Snap to Grid, 2-19
soft keyboard, 7-10
software requirements,
1-8
Spell Check, 2-21, 3-6,
3-11
Spell Check Options dia-
log box, 3-11
Spell checking, 7-23
setting defaults,
7-23
using, 7-25
stand-alone utilities, 9-1
starting ElixirForm, 1-8
static data, 1-1
sticky lines, 5-5, 5-7
System menu, 3-3
Filing Options, 3-3
Reset to Defaults,
3-4
Save Configuration,
3-4
Usage Switches, 3-3

T

template, 2-24
defaults, 2-25
Template Options dialog
box, 2-25, 3-11
Docutag/dataMerge
- data tags, 2-14
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attributes, 7-3

text - column height,
2-15

boxed, 7-6 text - column width,
color, 7-4 2-14
copying, 7-19 text - direction, 2-12
creating, 7-1 text - draw column
cut and paste, 7-19 box boundaries,
deleting, 7-20 2-15
editing, 7-14 text - inter-
free, 7-6 character/inter-word
importing, 7-11 spacing, 2-12
joining, 7-17 text - justification,
justification, 7-4 2-13
moving, 7-18 text - lines per inch,
options, 4-13 2-13
Text and Font Options text - positioning,
dialog box, 3-7, 4-13 2-13
Text toolbox, 7-3 text - remove redun-

add/remove font
from list, 2-16, 7-7
boxed text/free text,
7-6

color, 7-4

column width and
height, 7-5

data tage - on/off,
7-5

draw column box
boundaries, 7-5

f, 2-15, 7-7

font preview panel,
2-16, 7-8
intercharacter/interw
ord spacing, 7-3
justification, 7-4
lines per inch, 7-4
load font list, 7-7
load font list/merge
font list/save font
list, 2-16

merge font list, 7-7
positioning, 7-4
remove redundant
spaces, 7-3

save font list, 7-7
soft keyboard, 7-8
split string, 7-3

dant spaces, 2-13
text - set column
width/height to de-
fine box, 2-15

text - soft keyboard,
2-16

text - split string,
2-13

text - text color, 2-14
text - word wrap-
ping, 2-13

text direction, 7-3
word wrapping, 7-3

toolbar, 2-18

current object - di-
mensions, 2-18
current object -
shape, 2-18

current object - start
coordinates, 2-18
digital ruler, 2-18,
4-4

graphic ruler, 2-19,
4-4

grid display, 2-19
long crosshair, 2-20,
4-6

redo, 2-20
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show/hide toolbox,

2-21

shap to grid, 2-19

spell check, 2-21

undo, 2-20

zoom in/out, 2-20,

4-6
Toolbox

displaying, 3-4
toolbox, 2-2

box tool, 2-7

circle tool, 2-10

image, 8-1

image tool, 2-17

line, 5-2

line tool, 2-5

path tool, 2-5

select tool, 2-3

text, 7-1

text tool, 2-12
Tools menu, 3-6

Box, 3-6

Circle, 3-6

Image, 3-6

Line, 3-6

Path, 3-6

Select, 3-6

Spell Check, 3-6

Text, 3-6
training, 1-3

U

Undo, 2-20

undo/redo, 2-30
usage switches, 4-18
Usage Switches dialog
box, 3-3, 4-18

user preferences, 2-27,

4-1

utilities, stand-alone, 9-1

utility
FONTCHG, 9-3

\"

variable/fixed data, 1-1

View menu, 3-7
Grid, 3-7
Long Crosshair, 3-7
Ruler, 3-7

W

Window menu, 3-4
Form, 3-4
Tile, 3-4
Toolbox, 3-4
Work area menu bar,
3-5
Edit menu, 3-5
Options menu, 3-7
Tools menu, 3-6
View menu, 3-7

Z
Zoom in/out, 2-20, 4-6
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